Business Analysis Tools
# Table of Contents

**Business Analysis Tools**  .......................................................... 4
Activity Diagram ................................................................. 5
Artifact .............................................................................. 7
Auditing .............................................................................. 9
Auto Names and Counters .................................................... 11
Balanced Scorecard ............................................................. 13
Baseline Tool ....................................................................... 15
Boundary ............................................................................ 17
Business Process Diagram ................................................... 19
Business Process Simulation .................................................. 21
Business Rules Model ............................................................ 23
Calendar .............................................................................. 25
Class Diagram ..................................................................... 27
Component Diagram ............................................................. 29
Dashboard Diagrams ............................................................. 31
Data Flow Diagram ............................................................... 33
Data Modeling Diagram ....................................................... 35
Database Builder ................................................................. 37
Decision Tree Diagram .......................................................... 39
Decision Table Editor ........................................................... 41
Deployment Diagram ............................................................ 42
Document Artifact ............................................................... 44
Documentation ...................................................................... 46
Element Appearance ............................................................. 48
Element Browser ................................................................. 50
Element Discussions ............................................................ 52
Entity Relationship Diagram .................................................. 53
Flow Chart Diagram .............................................................. 55
Gantt View .......................................................................... 58
Gap Analysis Matrix .............................................................. 60
Glossary ............................................................................. 62
Hand Drawn and Whiteboard Mode ......................................... 64
Image Manager ................................................................. 66
Import and Export Spreadsheets ............................................... 68
Info View ............................................................................ 69
Insert Related Elements ....................................................... 71
List View ........................................................................... 73
Maintenance Items ............................................................... 75
Mind Mapping Diagram ......................................................... 76
Model Mail .......................................................................... 78
Model Search ..................................................................... 80
Model Transformation ........................................................... 82
Model Views ........................................................................ 84
Organizational Chart Diagram ................................................ 86
Package Browser ............................................................... 88
Pan and Zoom ..................................................................... 90
Project Browser ............................................................... 92
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Management Items</td>
<td>94</td>
</tr>
<tr>
<td>Relationship Matrix</td>
<td>95</td>
</tr>
<tr>
<td>Requirement Properties</td>
<td>97</td>
</tr>
<tr>
<td>Requirements Checklist</td>
<td>99</td>
</tr>
<tr>
<td>Requirements Diagram</td>
<td>101</td>
</tr>
<tr>
<td>Risk Taxonomy</td>
<td>103</td>
</tr>
<tr>
<td>Roadmap Diagram</td>
<td>105</td>
</tr>
<tr>
<td>Scenario Builder</td>
<td>107</td>
</tr>
<tr>
<td>Schema Composer</td>
<td>109</td>
</tr>
<tr>
<td>Security</td>
<td>110</td>
</tr>
<tr>
<td>Sequence Diagram</td>
<td>112</td>
</tr>
<tr>
<td>Specification Manager</td>
<td>114</td>
</tr>
<tr>
<td>StateMachine Diagram</td>
<td>116</td>
</tr>
<tr>
<td>Stereotyping</td>
<td>118</td>
</tr>
<tr>
<td>Strategy Map</td>
<td>120</td>
</tr>
<tr>
<td>Tagged Values</td>
<td>122</td>
</tr>
<tr>
<td>Team Reviews</td>
<td>124</td>
</tr>
<tr>
<td>Testing</td>
<td>126</td>
</tr>
<tr>
<td>Traceability Window</td>
<td>128</td>
</tr>
<tr>
<td>Use Case Diagram</td>
<td>130</td>
</tr>
<tr>
<td>Use Case Estimation</td>
<td>132</td>
</tr>
<tr>
<td>User Story</td>
<td>134</td>
</tr>
<tr>
<td>Value Chain</td>
<td>136</td>
</tr>
<tr>
<td>Visual Filters</td>
<td>138</td>
</tr>
<tr>
<td>Wire Frame Diagram</td>
<td>140</td>
</tr>
<tr>
<td>Working Sets</td>
<td>143</td>
</tr>
<tr>
<td>XML Schema Generation and Import</td>
<td>145</td>
</tr>
</tbody>
</table>
Business Analysis Tools

Enterprise Architect is a sophisticated and flexible Business Analysis modeling tool that can be used by the analyst from planning through to product support. The tool can be used with any Business Analysis process and there is a wide range of features that allow analysts to work using their preferred methods, such as Word Processor views, Spreadsheet views, Diagrams, Relationship Matrix or a number of other core and extended features. The analyst will be happy in the knowledge that whatever the task is, there will be a tool to assist them to carry out their work, and the results will be stored in a sophisticated repository that can be accessed by other team members who will ultimately benefit from their work.

This Mind Map shows the landscape of the key Business Analysis tools that can be used to develop and manage the wide range of artefacts produced by the Business Analyst.
Activity Diagram

Getting to know the Activity Diagram

**Introducing the Activity Diagram**

The Activity Diagram is one of the Unified Modeling Language (UML) Behavioral diagrams that can be used to model a process or algorithm as a sequence of steps. It is a more sophisticated version of its close cousin the Flowchart diagram. Activity diagrams can be used to model Business Processes as a UML alternative to the BPMN Business Process Diagram and have the same ability to create a hierarchy of Activities in the Project Browser.

*Activity Diagram showing the use of Partitions*

The elements can be given a name and detailed descriptions can be added to the notes. By connecting the Activities, Decisions and Forks with connectors (Control Flows) a sequence of elements can describe the business process. A process hierarchy can be constructed by nesting Activities in the Project Browser and using the Child Diagram functionality to enable drill down from the value chain level down to the lowest level processes.

*Where to find the Activity Diagram*

Ribbon: Design > Diagram > New > UML Behavioral > Activity

Project Browser Caption Bar Menu: New Diagram | UML Behavioral | Activity

Project Browser Context Menu: Add Diagram... | UML Behavioral | Activity

**Usage of the Activity Diagram**

The Activity Diagram can be used to model any business or technical activity or notion that has a series of steps. This includes business and technical processes and also computer algorithms. The steps are connected by Control Flow relationships that show the sequencing of the steps. Decisions and Merges can be used to model choice and to further control the flow through the Activity. Forks and Joins can be added to split and reunite the flow of control and objects added to show how data is supplied and consumed.

**Options for the Activity Diagram**

Activity Diagrams can be drawn at different levels of formality from a Basic Flow Chart style of diagram used to represent a simple Business Process to a sophisticated Action based diagram that can be used to model a complex system.
There is a toolbox which contains a range of elements, relationships and Patterns for creating the models.

The Activity Diagram (like any diagram) can be viewed as an element list, which makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams to draw attention to parts of the diagrams, and the diagrams can be presented as hand drawn or in a whiteboard style by changing the properties of the diagram.

Learn more about the Activity Diagram
Artifact

Getting to know the Artifact

Introducing the Artifact

An Artifact can be used to represent an external file that resides outside the repository. This is particularly useful for making reference to external file sources including files such as word processor files, spreadsheets and web pages or files reachable by a Universal Resource Indicator (URI). They are also used for other purposes in Enterprise Architect such as for programming source code files and database Tables.

The external files can be opened by selecting the element in a diagram or the Project Browser and pressing Ctrl+E or the F12 key. Each file is opened either on a separate tab in the Diagram View workspace (if the file can be opened within Enterprise Architect) or in the default Windows viewer/editor for the file type (if the file cannot be opened within Enterprise Architect).

Usage of the Artifact

The Artifact is a powerful tool for connecting elements in the repository with external files or web resources. It is particularly useful when a file such as a spreadsheet, word processor, presentation or other file that resides outside the repository has to be referenced or connected to elements inside the repository. For example, a Business Case might have been written before the Enterprise Architect repository was established, in a word processor file stored in a corporate document registry available through a URL.

The file can simply be dragged onto any Enterprise Architect diagram, which will give the user the option to create an Artifact representing the external document. Leaving the default name will assign the name of the external file. A hyperlink will be created automatically. The Artifact in the repository acts as a surrogate, and any number of elements can be connected to it or Tagged Values added to it. The external file can be opened by simply selecting <Ctrl> <E> or <F12> or by using the 'Launch' option of the Artifact 'Properties' dialog.
The Artifact can be used to create references to project management documents or resources that are located in a Project Management Office registry.

It is also useful to create a virtual reference library inside Enterprise Architect, connecting to resources that reside outside the repository.

**Options for the Artifact**

The Artifact can be created as an External or an Internal file. When a file or resource is dragged onto a diagram, a menu will prompt the user to select the type of Artifact to create:

- 'Hyperlink' creates a Hyperlink element on the diagram; you can select a sub-option to define what happens when double-clicking on the Hyperlink: 'Open' displays the file content and 'Edit' opens it within the assigned file editor
- 'External' creates an Artifact element on the diagram that stores a hyperlink to the external file; press F12 or Ctrl+E to open the external file
- 'Internal' creates an Artifact element on the diagram and makes a copy of the file inside the repository; double-clicking the Artifact launches the internal document
- 'Insert' (graphics files only) inserts the file into the diagram as a filled Boundary element
Auditing

Getting to know Auditing

**Introducing Auditing**  
The Auditing feature can keep track of the changes to Requirements including what was changed, when it was changed and by whom. Auditing is by default disabled and must be enabled before the changes to requirements will be recorded. Once enabled it is a passive tool that silently records the changes to elements. It does not replace version control or baselines and in contradistinction to these tools it can not be used to return to a previous state of the model. Change management, governance and quality control are all aided by the use of Auditing.

**Where to find Auditing**

**Use of Auditing**  
Auditing can be used to track what was changed in a model, who changed it and when. There are a number of modes and a repository administrator can use the settings to specify what is recorded in the audit. While a baseline can be used to show the difference between a model and a snapshot at a point in time, the Auditing tool records each individual change; it can not, however, be used to revert to a previous state.

**Options for Auditing**  
There is a wide range of settings to configure auditing, starting with enabling or disabling the settings that determine which elements have an audit trail and the level of detail recorded. Audit logs can be exported from the repository to increase performance.
Learn more about Auditing

- Auditing
Auto Names and Counters

Getting to know Auto Names and Counters

**Introducing Auto Names and Counters**
To aid, regulate and enforce a naming standard, Enterprise Architect includes some capabilities to configure the default names assigned to new elements of a specific type. This is a useful feature when dealing with complex and large sets of requirements, but is also relevant when dealing with smaller data sets. Auto Names and Counters can be used to assign a sequential number to any element type including Requirements. It includes a prefix definition, a counter and a suffix definition allowing numbers such as: 'REQ007 - Manage Inventory' to be created.

**Where to find Auto Names and Counters**
Ribbon: Configure > Reference Data > Settings > Auto Names and Counters

**Usage of Auto Names and Counters**
Analysts and others can use the sequential number for communicating unambiguously about the requirements without having to use the often long requirement name. The 'Apply on Creation' option must be checked to start using the auto numbering feature, this can also be used to temporarily suspend auto naming for example if other types of requirements are being entered that don't need to have sequential numbers assigned.

**Options for Auto Names and Counters**
There are options to define the prefix, counter and suffix for a requirement.

**Learn more about Auto Names and Counters**
[Apply Auto Naming to Existing Elements](#)
Balanced Scorecard

Getting to know the Balanced Scorecard

Introducing the Balanced Scorecard

Balanced Scorecard is a strategic diagram that allows a balanced approach to performance measures to be modeled. The diagram can be created from a Pattern that adds and connects the four perspectives: Financial, Customer, Internal Business Process, Learning and Growth. Most organizations of any appreciable size will be using some type of Balanced Scorecard approach to align business activities to the vision and strategy of the organization, to monitor performance against strategic goals and to improve communication. The Balanced Scorecard diagram is part of a set of strategic diagrams that allow many aspects of an organization's business to be modeled.

Business Process Perspective
- Move to Internet Channel
- Reduce Processing Time
- Broaden Product Offering
- Understand Customer Segments

Financial Perspective
- Broaden Revenue Base
- Improve Operating Efficiency
- Reduce Reliance of Domestic Customers

Customer Perspective
- Product Range
- Service Excellence
- Innovative and Reliable
- Trusted Business Partner

Learning & Growth Perspective
- Increase Employee Job Satisfaction
- Increase Employee Productivity
- Hire Internet Aware Technical Staff
- Hire multi-Channel Sales Executives

VISION & STRATEGY

Where to find the Balanced Scorecard

Ribbon: Design > Diagram > New > Strategic Modeling > Balanced Scorecard
Project Browser Caption Bar Menu: New Diagram | Strategic Modeling | Balanced Scorecard
Project Browser context menu: Add Diagram... | Strategic Modeling | Balanced Scorecard

Usage of the Balanced Scorecard

A Balanced Scorecard can be used to ensure business activities are aligned to the vision and strategy of the organization, to monitor performance against strategic goals and to improve communication.
Options for the Balanced Scorecard

The Classes representing the four perspectives can be traced to other elements in the models such as Goals and Business Capabilities and also to linked documents that allow the perspectives to be documented.

Learn more about the Balanced Scorecard

Balanced Scorecard
Baseline Tool

Getting to Know the Baseline Tool

Introducing the Baseline Tool

The Baseline Tool can capture a snapshot of the Requirements at a point in time and then at a later time the repository can be compared to this (or another baseline) for the purpose of determining what has changed. Any number of baselines can be created and labeled and there is a baseline comparison tool which displays the differences between the baseline and the model and allows the modeler to revert a change in the model to a baseline at a granular level.

Where to find the Baseline Tool

Project Browser Context Menu: Package Control | Package Baselines...

Usage of the Baseline Tool

Baselines are also useful when a formal requirements process is being followed or the Requirements form part of a contact, as the baseline can keep a snapshot of the requirements at important milestones such as contract signing or requirement phase sign off. This is also applicable to iterative and incremental processes such as Agile methods, as the requirements can be baselined before or even after a Sprint. When Requirements are still volatile and the Requirements' owners are still formulating their needs, a baseline can be created to take a snapshot at important points in the analysis phase, such as after an elicitation workshop.

Options for the Baseline Tool

There are several options that can be applied to configure the way the Baseline Compare tool presents information; these are available from the Options button on the Baselines window.
Learn more about the Baseline Tool Package Baselines
# Boundary

## Getting to know the Boundary

### Introducing the Boundary

The Boundary element is derived from the Use Case system boundary but can be used extensively in other contexts as a way of describing a separation between a system or part of a system and its external environment. Any number of Boundaries can be added to a diagram and other elements such as Use Cases, Features, Requirements, Components and more can be placed inside the boundary. The properties of the Boundary can be altered to show a number of compartments organized into vertical and horizontal swimlanes. The border style and opacity of the Boundary can also be set.

### Stakeholder Onion Diagram

This diagram indicates the level of involvement the stakeholders have with the solution, which stakeholders will interact directly with the solution or participate in a business process, which are part of the whole organization, and which are outside the organization.

### Where to find the Boundary

UML Elements Toolbar | Boundary
Common Toolbox Page | Boundary

### Usage of the Boundary

The Boundary element is particularly useful for defining what is inside a system (or part of a system) and what is outside. It can be used to show the Use Cases of a
system or subsystem, the in-scope Features or Requirements. Diagrams created for management and non-technical audiences will benefit from the use of Boundaries which can be colored and nested to have visual appeal and business meaning. It is essentially a diagrammatic device and does not appear in the Project Browser. If a formal and structural grouping of elements is needed the modeler could consider the use of a Package.

**Options for the Boundary**

The Boundary can be configured to have a number of vertical and horizontal swimlanes, which are useful for grouping elements into different sections of the boundary, creating a matrix effect. The Border Style can also be configured to allow different line styles which can then be colored using the standard element appearance settings. Also choosing the ‘Solid’ options allows the Boundary's fill color to be set.

![Boundary Properties](image)

**Learn more about the Boundary**

[Boundary](#)
**Business Process Diagram**

**Getting to know the Business Process Diagram**

**Introducing the Business Process Diagram**

The Business Process Diagram is part of the Business Process Model and Notation (BPMN) and is the main diagram type for defining business processes. The diagram can include Start, Intermediate, End Events, Business Processes, Activities, Gateways and Pools and Lanes and more. The elements can be given a name and detailed descriptions can be added to the notes. By connecting the flow objects with connectors a sequence of activities and gateways and events can describe the business process.

![Business Process Diagram](image)

A process hierarchy can be constructed by nesting Business Processes and Activities in the Project Browser and using the Child Diagram functionality to enable drill down from the value chain level down to the lowest level processes.

**Where to find the Business Process Diagram**

- Ribbon: Design > Diagram > New > BPMN x.y > Business Process
- Project Browser Caption Bar Menu: New Diagram | BPMN x.y | Business Process
- Project Browser context menu: Add Diagram... | BPMN x.y | Business Process

**Usage of the Business Process Diagram**

Business Process Diagrams can be used to model the Business Processes in an entire organization or part of an organization. Business Processes can be created to represent the current or future state of the organization at any level of detail from the value chain down to a process performer level. A process hierarchy would typically be defined that would set the standards for the number of levels, naming, organisation of the processes and more.

**Options for the Business Process Diagram**

Business Process Diagrams can be drawn at different levels of formality from a Basic Flow Chart style of diagram used to represent a simple Business Process to a sophisticated diagram making use of many of the markers for Events and Activities to describe complex business processes. There is a toolbox which contains a range of elements, relationships and Patterns for creating the models.
The Business Process Diagram can also be used to generate Business Process Execution Language (BPEL) which is an XML language that can be ingested by a number of tools.

The Business Process Diagram (like any diagram) can be viewed as an element list which makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams to draw attention to parts of the diagrams.

Learn more about the Business Process Diagram
Business Process Simulation

Getting to know Business Process Simulation

Introducing Business Process Simulation
The BPSim facility provides a way of simulating processes written in Business Process Model and Notation (BPMN), providing valuable results that can be used in process analysis. The BPMN models are augmented with extra data as parameters to the simulation. It allows structural and capacity analysis to be performed, providing for pre- and post-execution optimization. Enterprise Architect allows you to construct the Business Process Models and enter the appropriate data, which is then sent to a BPSim Simulation engine.

Where to find Business Process Simulation
You can purchase and download the MDG BPSim Execution Engine from the 'Products' page of the Sparx Systems web site.

Usage of Business Process Simulation
Business Process Simulation is essentially used to mimic real world or planned processes in a model, providing a low cost way of determining the effectiveness or value of a Business Process. An analyst can assign operating information to a model and then assess the quality or effectiveness of the solution based on information received back from the Simulation engine. Simulations can be run any number of times adjusting configuration information. The Simulation can be performed on current state and future state processes as required. It is common practice only to investigate critical or problematic processes.

Options for Business Process Simulation
The configurations created inside the repository and the BPMN Business Process Diagrams can be exported in a standard format and consumed by any standards compliant BPSim engine. Sparx Systems sells a BPSim Compliant simulator available in the MDG BPSim Execution Engine that allows the simulation to be performed inside the tool. Simulation results can be stored in the engine and used for cross simulation comparison.

Learn more about Business Process Simulation
Business Process Simulation
Business Rules Model

Getting to know the Business Rule Model

Introducing the Business Rule Model

The Business Rules Model provides a way of formally defining business rules including the way they are sequenced and the domain elements they relate to. The model allows Business Rules to be formally represented in a way that prepares for the automatic generation of application (programming) code that would ultimately be used to implement the rules. There are three main parts to the notation for documenting the rules as follows:

1. The Business Rules that express a Policy and are applicable to a Business Process.
2. The Business Rule Tasks that express a task or decision that the business processes must make.
3. The domain or information elements that represent the vocabulary or facts that the Business Rules relate to.

The Business Rules can also be related to Policies from which they derive and Requirements which they realize and application services that implement them.

Where to find the Business Rule Model

Ribbon: Design > Diagram > New > Business Rule Model | Rule Flow, Rule Model

Project Browser Caption Bar Menu: New Diagram | Business Rule Model | Rule Flow, Rule Model

Project Browser context menu: Add Diagram... | Business Rules Model | Rule Flow, Rule Model

Usage of the Business Rule Model

The Business Rules Model can be used to formally model business rules and the way they are applied in a rule task. The model provides a useful way of structuring the rules as a group by connecting them to a Rule Task which can be related to the Business Process where the rules are being applied. This has the effect of reducing the clutter on a Business Process Diagram and showing how the Business Rules...
apply as a set. The important information elements and facts can also be related to the Rule Tasks again reducing the clutter of connecting individual domain elements with specific rules.

**Options for the Business Rule Model**

The Business Rules and the Rule Tasks can be related to Policies, Requirements, Business Processes and other model elements creating an articulated model that shows how the business rules are applied.

Behavioral models can also be generated from the Business Rules Models.

Learn more about the Business Rule Model

![Business Rule Model](image)
Calendar

Getting to know the Calendar

Introducing the Calendar

The Calendar is a fully featured mechanism for recording the important events in an initiative and displaying other information such as resource allocation. There are day, week and month views and the display can be set to show Calendar entries, Project Tasks and Resource Allocation. When a resource has been allocated - for example to analyze a set of requirements - a user can drill through from the Calendar to the requirements' location in the Project Browser.

There are also fully configurable Event Types, Categories and colors. The work of a Business Analyst will involve a wide range of events including things like: workshops, interviews, focus groups, collaborative games, brainstorming sessions, reviews, observations and meetings. All of these events can be conveniently recorded and managed in the Calendar. When resources have been allocated to elements and tasks have been assigned to individuals these can be displayed in the Calendar.

Where to find the Calendar

Ribbon: Start > Today > Calendar

Usage of the Calendar

The Calendar can be used to schedule and view events such as meetings, milestones, reviews, workshops and more. It can be used to view the allocation of resources to elements in the repository such as who is analyzing a set of requirements. It can also be used to view Project Tasks. An analyst can conveniently click through to the elements in the Project Browser or the Project Tasks.

Options for the Calendar

The Calendar has a number of options including the ability to create recurrent events. There is an options toolbar icon that allows aspects of the Calendar's appearance to be configured.
Learn more about the Calendar

[Calendar]
Class Diagram

Getting to know the Class Diagram

Introducing the Class Diagram

The Class Diagram is one of the Unified Modeling Language (UML) Structural diagrams that can be used to model a wide range of things. It is a general purpose diagram for modeling entities in the business and technical domains including terms and concepts Business Rules and Capabilities to XML and Database Schemas.

![Class Diagram Image]

This diagram shows how a class diagram can be used to create a conceptual model that describes and relates the business vocabulary. The elements have notes describing their purpose and associations. Relationships and multiplicities describe how they relate to other business terms.

Where to find the Class Diagram

Ribbon: Design > Diagram > New > UML Structural > Class
Project Browser Caption Bar Menu: New Diagram | UML Structural | Class
Project Browser Context Menu: Add Diagram... | UML Structural | Class

Usage of the Class Diagram

The Class Diagram can be used whenever a logical or structural representation of a system is required. It has applicability for modeling both business and technical concepts and can be used to model information and structures such as XML and database schemas.

Options for the Class Diagram

The Class Diagram (like any diagram) can be viewed as an element list which makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams to draw attention to parts of the diagrams and the diagrams can be presented as hand drawn or in a whiteboard style by changing the properties of the diagram.
Learn more about the Class Diagram

Class Diagram
Component Diagram

Getting to know the Component Diagram

Introducing the Component Diagram

The Component Diagram is one of the Unified Modeling Language Structural diagrams that can be used to model the logical components that make up a system. They can be used to model the applications of an organization including their Provided and Required Interfaces and the information that is exchanged between the interfaces.

<table>
<thead>
<tr>
<th>Customer Relationship Manager</th>
<th>Entity Financial</th>
</tr>
</thead>
<tbody>
<tr>
<td>ef</td>
<td>Sales Data «flow»</td>
</tr>
<tr>
<td></td>
<td>Entity Financial</td>
</tr>
</tbody>
</table>

This Component Diagram shows the use of Ports and Provided and Required Interfaces and Information Flows to show what information flows between two Enterprise Systems at an Architectural Building Block Level.

Component hierarchies can be created that show how top levels systems or applications are broken down to lower level Components. The Components can be given a name, detailed descriptions can be added and additional properties can be added using Tagged Values.

Where to find the Component Diagram

Ribbon: Design > Diagram > New > UML Structural > Component
Project Browser Caption Bar Menu: New Diagram | UML Structural | Component
Project Browser Context Menu: Add Diagram... | UML Structural | Component

Usage of the Component Diagram

The Component Diagram can be used to model logical or physical parts of a system including current and future state Components. Application Architectures often use a number of Component Diagrams to describe the architecture of the applications and how they interact. The interaction between the applications can be shown using a combination of Ports and Provided and Required Interfaces that describe how the Components are wired together.

Options for the Component Diagram

Component Diagrams can be drawn at a number of levels of formality from simple diagrams that show the dependencies between Components to sophisticated diagrams using Ports, Interfaces and Information flows.
There is a toolbox which contains a range of elements, relationships and Patterns for creating Component diagrams.

The Component Diagram (like any diagram) can be viewed as an element list that makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams, to draw attention to parts of the diagrams, and the diagrams can be presented as hand drawn or in a whiteboard style by changing the properties of the diagram.

Learn more about the Component Diagram
Dashboard Diagrams

Getting to Know the Dashboard Diagrams

Introducing Dashboard Diagrams
The Dashboard Diagrams allow high quality charts and graphs to be created to display repository information in a visually compelling way, such as the ratio of Requirement Priorities in a pie chart. There is a toolbox page of pre-configured charts and graphs, but the user is free to create and save any number of charts sourcing data from anywhere in the repository. The charts and graphs provide valuable summary information that assists in the management of requirements. High level reporting and project status can be easily tracked and documented using the numerous charts and report elements available that tightly link in with the model content and status.

![Pie Chart Element](image)

*This diagram shows a Pie Chart element depicting element priority for all the requirements in a selected package. It provides a useful summary for a requirements manager and is dynamically updated when the Priority changes and the diagram is reopened.*

Where to find Dashboard Diagrams
Project Browser Context Menu: Add Diagram... | Extended | Dashboard

Usage of Dashboard Diagrams
Dashboard Diagrams present compelling views of information such as the Status of Requirements in a particular release of the system that can be viewed inside the model or conveniently copied directly into management or project team presentations. They are useful for planning an iteration such as an Agile sprint to view how ready the requirements are for the implementation team; for example to view what percentage of the Requirements have been approved and are of high priority.

Options for Dashboard Diagrams
The Standard Charts and Graphs available from the toolbox can be configured in a number of ways, including changing the source, applying filters or modifying the appearance of the chart as indicated in this diagram, available from the chart's Properties window using the 'Appearance' section.
Learn more about Dashboard Diagrams

Charts
Data Flow Diagram

Getting to know the Data Flow Diagram

Introducing the Data Flow Diagram

The Data Flow Diagram (DFD) is part of the Structured Systems Analysis and Design Method and is used to show the way that data flows through a system including the Processes, Data Stores and Entities that relate to the data.

A hierarch of diagrams is typically created that start from the Context Diagram which is said to be at ‘level 0’ in the hierarchy.

Where to find the Data Flow Diagram

Ribbon: Design > Diagram > New > Data Flow Diagrams > Data Flow Diagram
Project Browser Caption Bar Menu: New Diagram | Data Flow Diagrams | Data Flow Diagram
Project Browser context menu: Add Diagram... | Data Flow Diagrams | Data Flow Diagram

Usage of the Data Flow Diagram

The Data Flow Diagram can be used to create a data and process centric view of a system at any level. While the BPMN Business Process Diagram is not centered on data the Data Flow Diagram is data centric and shows which Processes consume, produce and store data. The diagrams are useful for a data analyst who needs to know how data moves through a system right from the context level where data flows between external entities and the system down to the lowest level.
Options for the Data Flow Diagram

The Data Flow Diagram can be assembled into a hierarchy and drill down to lower level diagrams can be achieved using the Child Diagram functionality. The Processes can be organized into a hierarch using the Project Browser and the Child Diagrams can be nested under each Process node in the Project Browser tree.

Colors can be used to represent particular data and how it flows through the system. Target and Future state diagrams can be drawn and transitions can describe how processes can be improved and made more efficient.

The Data Flow Diagram (like any diagram) can be viewed as an element list which makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams to draw attention to parts of the diagrams and the diagrams can be presented as hand drawn or in a whiteboard style by changing the properties of the diagram.

Learn more about the Data Flow Diagram [Data Flow Diagram]
Data Modeling Diagram

Getting to know the Data Modeling Diagram

Introducing the Data Modeling Diagram

The Data Modeling Diagram is used to create or view graphical models of relational database system schemas including a range of database objects. The diagrams can be drawn at a logical or a physical level. When a physical schema is being represented the modeler can choose the correct RDBMS which will enable the appropriate data types. Tables, Views, Stored Procedures and other objects are connected showing the way they are related to each other. Tables are the central element of the schema and can show the contained columns including datatypes, indexes and keys.

Where to find the Data Modeling Diagram

Ribbon: Design > Diagram > New > Extended > Data Modeling
Project Browser Caption Bar Menu: New Diagram | Extended | Data Modeling
Project Browser Context Menu: Add Diagram... | Extended | Data Modeling

Usage of the Data Modeling Diagram

The Data Modeling Diagram can be used to create database schemas or to view schemas that have been reverse engineered from a live database connection or transformed from a more primitive model. It is a useful diagram to visualize the connections between a variety of database objects. They can also be used to show traces back to other elements such as Requirements, logical Components, and Business Rules.

Options for the Data

A schema can be created from scratch, generated by a Model Transformation or
Modeling Diagram

reverse engineered from an existing database through an ODBC connection. The schema can contain a range of database objects, including:

- Tables
- Views
- Procedures
- Sequences
- Functions
- Associations
- Database Connections

Primary, Foreign and Unique keys can also be modeled and displayed on the diagram.

There are also several different notations that can be used, including:

- Unified Modeling Language (UML)
- Information Engineering
- Integration DEFinition for Information Modeling (IDEF 1X)

The notations can be interchanged by changing the 'Connector Notation' property.

Diagram Filters can also be used when presenting the diagrams to draw attention to parts of the diagrams, and the diagrams can be presented as hand drawn or in a whiteboard style by changing the properties of the diagram.

Learn more about the Data Modeling Diagram

Data Modeling Diagram
Database Builder

Getting to know the Database Builder

**Introducing the Database Builder**

The Database Builder is the primary tool for working with data models. It is a purpose built tool that provides a single interface for performing database-related modeling tasks. New data models and databases can be created or existing ones reverse engineered into the tool. The data modeler, database owner or administrator can work within the tool and can connect through to live databases to synchronize the models with the live databases. There is support for most database management systems and connections can be made to production, pre-production, test or development databases.

![Database Builder screenshot](image.png)

**Where to find the Database Builder**

Ribbon: Design > Tools > Database Builder
Ribbon: Code > Tools > Data Models > Database Builder

**Usage of the Database Builder**

The Database Builder can be used to create new logical and physical data models and to generate databases from these models. The tool can also be used to reverse engineer any number of existing databases into a model, allowing models to be compared and reasoned about.

**Options for the Database Builder**

Data elements such as Tables, Views and Stored Procedures that are represented in the Database Builder can be connected to other elements in the repository such as conceptual model elements or Requirements, Use Cases, User Stories, System Components and more. This allows the models to be traced and impact analysis to be performed creating a relationship between these important data representations and the rest of the models.

There is a SQL Scratch Pad tool that can be used to develop and execute ad-hoc SQL queries against a live database via an ODBC connection.
A Database Compare tool allows a data model to be compared to a live database and if required to be synchronized accepting the changes in either direction. 

The Execute DDL tools allows Database Definition Language (DDL) statements generated from the models to be executed against a live database and for the results to be viewed and analyzed.

Learn more about the Database Builder - Database Builder
Decision Tree Diagram

Getting to know the Decision Tree Diagram

Introducing the Decision Tree Diagram

Decision Trees are an effective way of graphically representing a number of options and provide a mechanism to investigate the possible outcomes and benefits of choosing those options. They can also assist the analyst to form a balanced picture of the risks and benefits associated with each possible course of action. They are a close cousin of the Decision Table but have the benefit of being graphical. Enterprise Architect has a purpose built diagram allowing complex decisions to be modeled and displayed including probabilities and uncertainty.

Usage of the Decision Tree Diagram

Decision Trees can be used to help in decision making processes particularly when the decision involves a complex set of conditions that have different likelihoods of occurrence. They can be used for strategic or operational decision analysis and can help to formalize the basis of decision making particularly when it is imperative that actions that are taken are based on formal analysis or have expensive consequences. A Decision Tree can be used to present a graphical picture of a Decision Table for stakeholders who are more comfortable viewing diagrams rather than tables and documents.

Options for the Decision Tree Diagram

Decision trees can be drawn with varying levels of formality from simple trees with a series of decisions resulting in outcomes to more formal trees that involve uncertainty with probability values assigned or formulaic expressions with input parameters. The 'Decision Tree' toolbox page contains a range of elements that can be used, and two Patterns that can be used to create a diagram giving the analyst a starting point.
Diagram Filters can also be used when presenting the diagrams to draw attention to parts of the diagrams and the diagrams can be presented as hand drawn or in a whiteboard style by changing the properties of the diagram.

Learn more about the Decision Tree Diagram

Decision Tree Diagram
Decision Table Editor

Getting to know the Decision Table Editor

**Introducing the Decision Table Editor**

The Decision Table Editor provides a convenient and intuitive way to record the way that decisions are made in an organization or industry. A number of conditions can be defined and columns can be added that contain values, one or more conclusions can be added with applicable columns where the decision value is entered. The Decision Table Editor is based on the Object Management Groups (OMG) Decision Model and Notation (DMN) specification and can be used to generate implementation code using predefined macros.

An analyst will occasionally need to record the way that decisions are made in an organization in a formal way. There is often also the need to express the conditions and the resulting decisions in a way that will assist an implementation team design a solution. The Decision Table Editor built into Enterprise Architect can assist in expressing and implementing the way that decisions are made.

![Image of Decision Table Editor]

**Where to find the Decision Table Editor**

Ribbon: Design > Element > Decisions > Manage Decisions

**Usage of the Decision Table Editor**

An analyst will occasionally need to record the way that decisions are made in an organization in a formal way. There is often also the need to express the conditions and the resulting decisions in a way that will assist an implementation team design a solution. The Decision Table Editor built into Enterprise Architect can assist in expressing and implementing the way that decisions are made.

**Options for the Decision Table Editor**

The Decision Table Editor can be used simply to record the conditions and the conclusions that form the basis of decision making. Alternatively implementation code can be generated using the Enterprise Architect Simulation Library (EASL) code generation macros.

**Learn more about the Decision Table Editor**

[Decision Table Editor]
Deployment Diagram

Getting to know the Deployment Diagram

Introducing the Deployment Diagram

The Deployment Diagram is one of the Unified Modeling Language (UML) Structural diagrams that can be used to model infrastructure including a wide range of deployment environments. Both physical and virtual environments can be modeled including infrastructure and networking services and protocols.

Where to find the Deployment Diagram

Ribbon: Design > Diagram > New > UML Structural > Deployment

Project Browser Caption Bar Menu: New Diagram | UML Structural | Deployment

Project Browser Context Menu: Add Diagram... | UML Structural | Deployment

Usage of the Deployment Diagram

The Deployment Diagram can be used to model a wide range of infrastructure and networking environments including physical and virtual environments. It is quite common to model a number of different environments including: production, pre-production, test and development environments. The diagram can be used to model Servers, Devices, Networks, Execution Environments. Switches, Routers, IP Addresses and the Software Components and Artifacts deployed.

Options for the Deployment Diagram

It is quite common to use the Deployment Diagram to model a number of different environments, including production, pre-production, test and development environments. Alternate images can be used in diagrams to represent infrastructure and networking devices such as Networks, Servers, Routers, Switches and more, making the diagrams more compelling and appealing to their audience. The diagrams can be included in documentation generated automatically using the Document Generator.
There is a toolbox which contains a range of elements, relationships and Patterns for creating Deployment diagrams.

The Deployment Diagram (like any diagram) can be viewed as an element list, which makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams to draw attention to parts of the diagrams and the diagrams can be presented as hand drawn or in a whiteboard style by changing the properties of the diagram.

Learn more about the Deployment Diagram

Deployment Diagram
Document Artifact

Getting to know the Document Artifact

Introducing the Document Artifact

A Document Artifact is like a word processor file that can be created and stored directly inside the model to record structured documentation. It is a light-weight and convenient alternative to creating a document in your favorite word processor. It has many of the features you would expect in a word processing tool and allows you to create hyperlinks to content in the modeling Repository. An analyst will often be required to create structured documentation over and above what might properly be placed in an element's notes or in a corporate document repository. This could include things like interview plans, focus groups agendas, surveys and more. There is rarely a requirement to store this type of documentation in a corporate document repository and storing them inside the modeling repository has many benefits including being able to include hyperlinks to elements and diagrams contained in the Project Browser.

Where to find the Document Artifact

Toolbox: Common, Artifacts, Component, Documentation, Deployment Toolbox Page | Document Artifact

Usage of the Document Artifact

A Document Artifact can be used to add structured documentation in the form of a word processor (rtf) file. This can be a standalone element or it can be linked to another model element. In large organizations there is often a corporate repository for documents but in smaller organizations or when a document is less formal the document Artifact can be a useful mechanism for storing information. For example...
it can be used to document or plan a stakeholder workshop or focus group.

**Options for the Document Artifact**
When a Document Artifact is created there is an option to use a built-in or user defined template. Any number of templates can be created for documents such as focus groups, workshops surveys and plans.

Elements and diagrams can be dragged onto the document from the Project Browser, which allows readers to click through from the location in the document to the diagram or element.

Many of the features found in Word Processors are available, such as inserting pictures and tables, creating Tables of Contents and headers and footers, tracking changes to the document and more.

**Learn more about the Document Artifact**
Create Document Artifact
Documentation

Getting to know Documentation

Introducing Documentation

The documentation features can be used to automatically generate a wide range of documentation directly from the models. These can be document based such as PDF and Docx format or html based. Flexible templates can be used to completely tailor the documents that are generated including company logos, tables of content, tables of element information and diagrams. Ad-hoc reports can also be created from a number of tools such as the Glossary and the Search Window.

Where to find Documentation

Modelers, Analysts, Architects, Project managers and others can use the facility to produce a wide range of document based publications and reports, such as a: System Requirements Specification, Use Case Report, Data Dictionary, Solution Architecture Description and more. It can also be used for Ad-hoc reporting to create reports such as a list of the most volatile requirements. Html documentation can also be published to allow stakeholders who don't have access to Enterprise Architect to view the models from an Intranet site that can just be placed on a file system without the need for a Web Server.

Options for Documentation

There are several options that can be set to tailor the information that is included in a generated document, including the ordering of elements and diagrams and hiding certain elements. Filters and word substitutions and other options can also be applied.
Learn more about Documentation

- Model Publishing
Element Appearance

Getting to know Element Appearance

Introducing Element Appearance

All elements in the repository have a global default appearance which is defined in the Options Window. Individual elements can set a global appearance which overrides the default setting for all elements and applies to the specified element wherever it appears in diagrams. An element's appearance can also be changed at the level of an individual diagram by using the color and font pickers. Images and other shapes can also be applied to make the element more appealing.
Global for an Element
Context Menu: Appearance | Default Appearance

Local for a Diagram Object
Ribbon: Layout > Style > Set Font, Text Color, Fill Color, Line Color, Line Width
Diagram Toolbar: Set Font, Text Color, Fill Color, Line Color, Line Width
Element Icons: Set Font, Text Color, Fill Color, Line Color, Line Width (top right corner of diagram object)

**Usage of Element Appearance**
The Element Appearance is useful to convey different meaning to a number of audiences and stakeholders. The global element settings ensure the entire repository is by default consistent and these can be changed to suit an organization. The default element appearance settings ensure that an element is consistently represented whenever it is used on diagrams. The local appearance settings allow an element to appear differently on a specific diagram. Some stakeholders will also prefer to see an element represented as an image or by a different shape.

**Options for Element Appearance**
Apart from the setting of Font Style, Text Color, Element Fill and Border Color and Line thickness, elements can be assigned an alternate image or a completely different geometry using the shape script facility and applied to a stereotype. The images can be assigned from the

**Learn more about the TOOL**
[Element Appearance](#)
Element Browser

Getting to know the Element Browser

Introducing the Element Browser

The Element Browser provides a view of all the important aspects of an element including Attributes, Operations, Tagged Values, Files, Internal Requirements, Relationships, Constraints Maintenance and Project Maintenance Items and more. It is a useful window to use in conjunction with the Project Browser as it provides all the details of an element selected in the Project Browser conveniently collected in a single view.

Where to find the Element Browser

Ribbon: Show > Window > Element Browser
Ribbon: Start > Explore > Element Browser

Usage of the Element Browser

The Element Browser can be used to view and to edit all the important aspects of an element. While the Project Browser will help the modeler navigate through and locate elements in the repository, the Element Browser will allow the element to be explored in detail.

Options for the Element

The Element Browser can be used to view and edit most of the aspects of an
Browser element. For example, Relationships can be viewed and deleted, Attributes and Operations, Constraints, Project Management and Maintenance items and more can be viewed and new ones created. Having the window open while viewing elements in the Project Browser will give a simple overview of which aspects of the element have been detailed, without the need to expand the + indicator to view the details.

New items can be added to the element and existing ones deleted directly from the Element Browser window from the context menu.

Learn more about the Element Browser

[Image of Element Browser window]
Element Discussions

Getting to know Element Discussions

**Introducing the Element Discussions**

The Element Discussions facility allows modelers to have conversations about elements posting discussions and replying to exiting posts. The discussions for all elements in the model are conveniently listed in the Discussions Review window allowing a modeler to see all the elements with posts.

![Element Discussions](image)

**Where to find Element Discussions**

To post or view an element's discussion

To view all discussions in the repository

**Usage of Element Discussions**

Element Discussions allow modelers to have conversations about elements without 'polluting' the element's notes with questions and modeling level comments such as 'Properties need to be added before the first release'. This feature brings the collaborative modeling platform alive where modelers can add informal discussions about elements emulating the discussions held in a physical workshop.

**Options for the Element Discussions**

The Discussion Review window has a number of options to tailor the discussions that are listed including defining the timeframe allowing older and perhaps less relevant discussions to be hidden.

![Visible Timeframe Options](image)

**Learn more about Element Discussions**

[Informal Element Discussions](#)
$\textbf{Entity Relationship Diagram}$

$\textbf{Getting to know the Entity Relationship Diagram}$

$\textbf{Introducing the Entity Relationship Diagram}$

The Entity Relationship Diagram is a visual device used to model information or data and is used as a schema that is a precursor to database modeling. There are a number of different representations that can be used but the style used in Enterprise Architect uses rectangles to represent Entities, ellipses to represent Attributes and diamonds to represent connections between Entities.

$\textbf{Entity-Relationship Diagrams}$

Entity Relationship Diagrams in Enterprise Architect are based on Chen's ERD building blocks:

- Entities (tables) are represented as rectangles.
- Attributes (columns) are represented as ellipses (joined to their entity).
- Relationships between the entities are represented as diamond-shape connectors.

ERD technology in Enterprise Architect assists you in every stage, from building conceptual data models to generating Data Definition Language (DDL) for the target DBMS.

Entity-Relationship Diagrams are available from the category 'Entity Relationship Diagrams'.

$\textbf{Where to find the Entity Relationship Diagram}$

Ribbon: Design > Diagram > New > Entity Relationship Diagram > Entity Relationship

Project Browser Caption Bar Menu: New Diagram | Entity Relationship Diagram | Entity Relationship

Project Browser context menu: Add Diagram... | Entity Relationship Diagram | Entity Relationship

$\textbf{Usage of the Entity Relationship Diagram}$

They are used by some data modelers as a way of ensuring independence from the physical data models that are used to represent the schema of a given Relational Database Management System database. They also provide a more appealing means of communicating with non technical stakeholders.

$\textbf{Options for the Entity Relationship Diagram}$

Entity Relationship Diagrams can be drawn to include all of the Entities in a given domain in a single diagram or, alternatively, a number of diagrams can be created for different aspects of the domain. Diagram Filters can be used in presentations to focus on specific parts of a diagram that are of interest to the audience. The Documentation Generator can also be used to produce a data dictionary describing the Entities, their Attributes and their relationships with other Entities.
There is a toolbox which contains a range of elements, relationships and Patterns for creating Entity Relationship diagrams.

The Entity Relationship diagram (like any diagram) can be viewed as an element list, which makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams to draw attention to parts of the diagrams, and the diagrams can be presented as hand drawn or in a whiteboard style by changing the properties of the diagram.

Learn more about the Entity Relationship Diagram
Flow Chart Diagram

Getting to know the Flow Chart Diagram

**Introducing the Flow Chart Diagram**

The Flow Chart Diagram is a strategic diagram that allows the steps in a process, workflow or algorithm to be ordered in a sequence and displayed graphically. The steps are modeled as rectangles and choices are modeled as diamonds, there are inputs and outputs and data stores available for modeling the things that are consumed, produced and stored by the process.
Flow Chart Diagram

A Flow Chart is a graphical representation of a sequence of events, helping decision makers understand the relationship between their decisions and a given outcome. Flow Charts use a range of simple geometric shapes to represent a process, decision, storage or output.

Flow Chart diagrams are available from the 'Strategic Modeling' category. The associated toolbox offers a range of elements and connectors that specifically target that diagram type.

Where to find the Flow Chart Diagram
Ribbon: Design > Diagram > New > Strategic Modeling > Flow Chart
Project Browser Caption Bar Menu: New Diagram | Strategic Modeling | Flow Chart
Project Browser context menu: Add Diagram... | Strategic Modeling | Flow Chart

Usage of the Flow Chart
The Flow Chart Diagram can be used for visualizing, analyzing and
Diagram

communicating about the steps and outcomes in workflows, processes and computer algorithms.

Options for the Flow Chart Diagram

Flow Chart Diagrams can have nested Activities allowing hierarchies to be defined. Responsible parties can be defined by the use of swim lanes.

The Flow Chart Diagram (like any diagram) can be viewed as an element list which makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams to draw attention to parts of the diagrams and the diagrams can be presented as hand drawn or in a whiteboard style by changing the properties of the diagram.

Learn more about the Flow Chart Diagram

Flow Chart Diagram
Gantt View

Getting to know the Gantt View

Introducing the Gantt View

The Gantt View is a tool for visualizing the elements in a Project, Package or Diagram and the resources that have been allocated to them. There are a number of different Gantt charts available:

- The Project Gantt View used to view elements across the entire repository
- Diagram Gantt View used to display the allocation of resources to the elements in a given diagram.
- Package Gantt View used to display the allocation of resources to the elements contained in a selected Package.

The tool will empower the traditional or agile project manager to ensure that a projects resources are allocated to repository content and help ensure high value outcomes are achieved right from within the repository.

Where to find the Gantt View

Ribbon: Design > Package > Gantt View
Ribbon: Design > Diagram > Gantt View
Diagram Context Menu: | Gantt View
Project Browser Context Menu: View as Gantt

Usage of the Gantt View

The Gantt View’s primary use is to display the allocation of resources to elements in the repository and to manage the work breakdown structure. There is a wide range of views and filters that can be applied to tailor the view or to make it more relevant to a particular audience. Allocations can be made to any elements in the repository from high level Packages level down to an individual element such as a Class, Activity or Change. It is a powerful tool for a project managers wanting to visualize how a team is being utilized and ultimately to deliver high value and high priority outcomes. Modelers working on a project can view their own work and update their progress while working on assigned tasks.

While broad changes can be made using the visual duration bars in the Gantt View it is common practice to use the tool in conjunction with the Resource Allocation
Options for the Gantt View

The Gantt View is a highly flexible tool that can be configured to display information in a number of different ways. Filters can be used to show only elements that have a particular status or more generally by using the Filter Bar and finding elements that contain the specified filter text in a particular column. It is also possible to filter the display by Start or Completion date or to just show overdue tasks.

Broad changes can be made to the duration of tasks by simply dragging the ends of the visual bars. The scale of time can be altered on the display to allow short and long term planning and to get condensed and expanded views.

The Gantt chart can conveniently be copied to the clipboard and pasted in to other applications or saved into a file. There is a wide range of other options that are available, making the tool invaluable to a team and schedule-based approach to modeling.
Gap Analysis Matrix

Getting to know the Gap Analysis Matrix

Introducing the Gap Analysis Matrix

The Gap Analysis Matrix is a specialized Relationship Matrix that is used to record the gaps that exist between two versions of some part of an enterprise. The gaps between two different versions of an architecture could be recorded, or the gaps in two versions of Capabilities or Staff Competencies, or two versions of Information or Data. The tool is structured like a spreadsheet with columns and rows. The elements that make up the baseline (starting point) are listed as columns and the elements that make up the target (end point) are listed as rows. There is a column for recording missing or eliminated elements and a row for recording new elements. At the intersection of a baseline element and target element notes can be added that describe any details of the relationship between the two elements.

Where to find the Gap Analysis Matrix

Ribbon: Design > Impact > Gap Analysis

Usage of the Gap Analysis Matrix

The Gap Analysis Matrix can be used for both business and technical analysis. It is a general purpose tool for recording the details of a comparison between different versions of some part of an enterprise. In business analysis it can be used to analyze Staff Competencies, Data and Information, Business Processes, Lines of Business and more, comparing them between current and future states of an enterprise. In Enterprise Architecture the matrix can be used to record gaps.
between baseline, transition and target architectures, comparing Capabilities, Architecture and Solution Components and more.

**Options for the Gap Analysis Matrix**

The Gap Analysis Matrix can be configured to display different parts of the repository. Once the appropriate packages have been chosen for the Target and Baseline and the types of elements have been selected for the filter the Gap element type can be selected. The element chosen for the gap will restrict the available elements to represent the gap for Missing or New elements in cells in the matrix. There are a number of choices available from the 'Options' menu, including being able to update, delete and save the Gap Analysis Matrix, giving it a name so that it can be recalled at a later time.

Learn more about the Gap Analysis Matrix

[Gap Analysis Matrix](#)
Glossary

Getting to know the Glossary

Introducing the Glossary

The Glossary is a project level lexicon of the important terms and their meanings categorized by type. Any number of terms, their types and meanings can be defined and these can be referenced from the notes of model elements. The terms can be included in documentation or generated as a stand-alone report. When working with domain specific requirement specifications, architectures and other models it is essential that new terms and over-ridden meanings for common words or phrases are kept in a suitable dictionary format to ensure proper understanding of documentation and specifications.

Where to find the Glossary

Usage of the Glossary

The project Glossary can be used to record the important terms of a project or domain grouped by the type of term, allowing business, technical and domain specific types to be defined. A glossary report can be generated as a stand alone report or the glossary can be included as a section of another document.

Options for the Glossary

The Glossary has a number of options to determine the terms that are displayed in the list and to define the style that is used for types of terms in documentation.

Learn more about the Glossary

Model Glossary
Hand Drawn and Whiteboard Mode

Getting to know Hand Drawn and Whiteboard Mode

**Introducing Hand Drawn and Whiteboard Mode**

Hand Drawn and Whiteboard Mode are display options available for any diagram that changes a system-drawn diagram to appear as though it was drawn by hand and, optionally, hand drawn on a whiteboard. It is a powerful device to engage an audience by presenting the diagram in a rough and more immediate style giving the impression that it is just a sketch that can be changed.

Both modes will present the diagram in a hand drawn style but the whiteboard mode will change the Fill color of the elements and the diagram background to white as though it had been drawn on a whiteboard.

![Diagram](image)

**Where to find the Hand Drawn and Whiteboard Mode**

Ribbon: Layout > Diagram > Appearance > White Board, Hand Drawn

Diagram Context Menu: Properties | Diagram | Whiteboard Mode, Hand Drawn

**Usage of the Hand Drawn and Whiteboard Mode**

The Hand Drawn diagram mode is a perfect tool for use in workshops and presentation to internal or external customers as a way of softening the representation of more formal elements which are normally displayed in their more rigid geometric forms. Audiences will tend to respond to the diagrams more favourably as they appear to be just sketches and not yet resolve as finished diagrams. Stakeholders who are not familiar with the formal modeling languages such as UML will typically be more engaged by these diagrams.

The Whiteboard mode will give the appearance that the diagram was sketched on the whiteboard again adding an immediacy to the drawing.

Both the Whiteboard Hand Drawn mode of presentation can be carried through to generated documentation that contains the diagram.

**Options for the Hand Drawn and Whiteboard Mode**

The Whiteboard mode will give the appearance that the diagram was sketched on the whiteboard again adding an immediacy to the drawing.

Both the Whiteboard Hand Drawn mode of presentation can be carried through to...
generated documentation that contains the diagram.

Learn more about the Hand Drawn and Whiteboard Mode

Hand Drawn and Whiteboard Mode
Image Manager

Getting to know the Image Manager

Introducing the Image Manager

The Image Manager is used to manage pictures in the Repository, allowing them to be maintained and reused across diagrams. Images can be inserted in a variety of formats including Bitmaps and Extended Windows Metafiles are then used to change the conventional appearance of elements to create more appealing and compelling diagrams.

Where to find the Image Manager

Defining Images
Ribbon: Configure | Reference Data | Images

Using Images
Element Context Menu: Appearance | Select Alternate Image

Usage of the Image Manager

The Image Manager's main use is to define pictures that can be used as alternate representation for elements in diagrams. For many business and networking diagrams the default appearance of an element such as a UML Class or Component can be replaced with an image from the Image Manager making the diagram more appealing to its audience. The Image Manager will also store images that are defined in included technologies.

Options for the Image Manager

The Image Manager allows Images to be imported in a variety of formats including Bitmaps and Extended Windows Metafiles. Images can be imported from the file system or conveniently from the Clipboard.
There is also an option to display the diagrams where the image has been used.

Learn more about the Image Manager

Image Manager
Import and Export Spreadsheets

Introducing Import and Export Spreadsheets

This facility is a useful mechanism to import Requirements that have been defined in a Spreadsheet or a Word Processor table into Enterprise Architect. Once in Enterprise Architect the Requirements can be managed and traced to elements such as business drivers and Scenarios and Components. Alternatively, Requirements in Enterprise Architect can be exported to a Spreadsheet for the purposes of providing them to a third party or for some type of numerical or statistical analysis. The mapping between fields in the Spreadsheet and the analogous properties in Enterprise Architect is completely configurable using a specification.

For more detailed information exchange, the Microsoft Office Add-In (available from Sparx Systems) provides additional functionality and integration points useful when dealing with complex Requirements.

Where to find Import and Export Spreadsheets

Use of Import and Export Spreadsheets

This feature can be used to import or export Requirements from a CSV file. Before a tool like Enterprise Architect is installed analysts might have used a Spreadsheet or a table in their favorite word processor to record requirements; these can conveniently be imported using the CSV import facility. Alternatively, Requirements sometimes have to be provided to a third party who will typically specify that they want them in a Spreadsheet file; this can be achieved using the export facility.

Options to Import and Export Spreadsheets

The import and export facility is completely configurable and has a user defined specification that can be used to determine how fields in the Spreadsheet file are mapped to Requirements properties in Enterprise Architect including being able to import and export fields to and from Tagged Values of the Requirement.

Learn more about Import and Export Spreadsheets

- CSV Import and Export
Info View

Getting to know the Info View

Introducing the Info View

The Info View is an alternative representation for an element that is typically more appealing to managers or non-technical stakeholders. The Info View displays the name, stereotype, notes and a small icon that represents the shape of the element. Other element properties can be displayed by using the Visible Properties window.

Usage of the Info View

The Info View is a useful alternative representation of an element in a diagram which is often appealing to managers and high level stakeholders. The Info View will show the name of the element, a small Icon that signifies the type of element, additional properties and the element's notes. It is useful in situations where the audience of the diagram does not need to know about the details such as Attributes, Operations, Database Columns, and other details.

Where to find the Info View

Element Context Menu: Info View | Enabled
Element Context Menu: Info View | Visible Properties

Options for the Info View

The properties that are displayed by the Info View representation can be configured to make the element more meaningful to particular audiences. The
Visible Properties windows allows properties to be selected for display.

A portion of the notes will be displayed using the available space in the Info View; if all the notes need to be displayed the diagram element can be resized to provide space for the text.

Learn more about the Info View

Info View
Insert Related Elements

Getting to know Insert Related Elements

Introducing Insert Related Elements

Insert Related Elements is a powerful productivity and exploration tool that allows diagrams to be created automatically from relationships that exist in the repository. Typically elements are added to the repository by a number of modelers and no single person will be totally aware of all the elements in the repository and their relationships. By placing a single element onto a diagram that acts as a context (or starting point) the Insert Related Elements facility can be used to explore the element's connections and to automatically draw a diagram using the context element as a starting point. This will almost seem like magic and powerful and expressive diagrams can be created that a modeler will not have seen before or not thought of creating.

Where to find Insert Related Elements

Ribbon: Design > Element > Insert Related
On diagram | Element Context Menu | Insert Related Elements

Usage of Insert Related Elements

The Insert Related Elements facility can be used to create a diagram automatically from its relationships in the repository, including the relations of the related elements themselves down to a deeper level. It can also be used as a discovery tool where the modeler wants to explore a model (or part of a model) they might not be familiar with. It is also useful in workshops when a number of model authors or other stakeholders are present to show the traceability between different parts of a repository.

Options for Insert Related Elements

Insert Related Elements has a flexible interface that allows the modeler to configure what types of relationship to include in the discovery and the direction of those relationships, the types of related elements to be included, the depth of the graph traversal and more. The related elements can be related to a specified namespace and once a set of related elements has been listed the modeler can choose which elements to insert into the diagram. A depth of 1 will just include the elements directly related to the context element, a depth of 2 will include the directly related elements and any elements directly related to them and so on up to
a depth of 5.

There is also the option to allow the tool to layout the diagram after the elements have been inserted.

Learn more about Insert Related Elements

Insert Related Elements
List View

Getting to know the List View

Introducing the List View

The List View is a powerful tool for viewing the contents of a package or a diagram as a list of elements; allowing the elements' properties to be viewed and edited in a convenient spreadsheet like view. Many analysts will prefer to view elements in a list and when details are changed the changes will be effective in every other view of the element including diagrams and the Project Browser. There are a wide range of options for filtering, sorting and grouping elements in the list based on a wide range of properties and tagged values.

Where to find the List View

Ribbon: Design > Package > List View
Diagram Context Menu: List View
Project Browser Context Menu: View as List

Usage of the List View

The List View can be used to get a different view of the elements contained in the Project Browser or a diagram and to visualize their properties in a single spreadsheet like view. It is particularly useful when dealing with non technical audiences or when the elements need to be sorted, filtered or grouped based on criteria such as Name, Status, Phase Version and more. Project Managers and others working with sets of elements will be able to analyze in a given package or diagram. There is also a related Gantt View where resource allocations, work completion and timings can be visualized.

Options for the List View

Additional properties can be added by using the Field Chooser and Tagged Value columns can also be added allowing a modeler to view the elements' native properties and Tagged Values side-by-side. The elements in the list can also be exported to a document report using any number of built-in or user defined
templates and generating to a variety of formats including Docx, PDF and RTF.

Learn more about the List View

List View
Maintenance Items

Getting to know Maintenance Items

Introducing Maintenance Items
Element Maintenance Items can be used with any element, including Requirements, Components, Classes and other elements to capture problems, changes, issues, tasks, events and decisions that affect an individual element. Using maintenance items to track official changes, additions and deletions to sets of Requirements, Components, User Stories and other specifications provides a sound basis for overall project governance and traceability.

![Maintenance Item Example](image)

Where to find Maintenance Items

Usage of Maintenance Items
Element Maintenance Items can be used to record a wide range of information about elements including: changes, issues and tasks and more. These can be used to track the way an element is altered and maintained and can provide information about the Item including the rationale for the alteration, status and priority. While the Baseline and Auditing features record what has changed automatically the Maintenance Items provide the flexibility for a modeler to specify details manually.

Options for Maintenance Items
There are a range of maintenance items that can be used to add information to elements these include: Defects, Changes, Issues, Tasks, Decisions and Events. Items can have information such as who requested the item, who completed the item and status and priority.

Learn more about Maintenance Items
Maintenance Items
Mind Mapping Diagram

Getting to know the Mind Mapping Diagram

Introducing the Mind Mapping Diagram

The Mind Mapping Diagram is a useful tool for recording ideas, thoughts and information in a simple and understandable format. The diagram is a type of spider (or radial) diagram where a Central Topic or idea is typically located at the centre of the diagram and Main Topic, Topic and Sub-Topics radiate out as the ideas are explored and recorded.

An analyst will often be required to take notes or record ideas (including their own) and information in the context of meetings, workshops and focus groups. The Mind Mapping diagram is a useful tool and its simple and appealing layout makes it accessible to everyone. Regardless of what formal languages or frameworks are being used to articulate requirements and processes and other artifacts the Mind Mapping diagram requires little or no explanation.

Where to find the Mind Mapping Diagram

Ribbon: Design > Diagram > New > Mind Mapping > MindMapping Diagram

Project Browser Caption Bar Menu: New Diagram | Mind Mapping | MindMapping Diagram

Project Browser context menu: Add Diagram... | Mind Mapping | MindMapping Diagram

Usage of the Mind Mapping Diagram

A MindMapping Diagram can be used to record ideas and information in the context of a workshop, focus group, meeting or even to get your own thoughts down. It becomes a compelling visual record of the communication and discussions and often acts as a precursor to more formal techniques such as requirements articulation, Architecture modeling database design and more. Requirements and other elements such as Capabilities, Acceptance Criteria, design Components, User Stories and more can all be traced back to Topics and Sub-Topics in a MindMapping Diagram.

(c) Sparx Systems 2015 - 2017
Options for the Mind Mapping Diagram

A MindMapping diagram can be made more expressive with the use of images and colors. The appearance of the Central Topic and Main topics could use an image that visually communicates the central idea. Colors can be applied to communicate concepts such as the importance or the owner of an idea or any other concept. Dependency relationships can be added to show how ideas relate to each other; for example, which stakeholders have specific interactions or which services depend on other services.

The MindMapping Diagram (like any diagram) can be viewed as an element list which makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams, to draw attention to parts of the diagrams. The diagrams can be presented as hand drawn or in a whiteboard style by changing the properties of the diagram.

Learn more about the Mind Mapping Diagram

Mind Mapping Diagram
Model Mail

Getting to know the Model Mail

Introducing the Model Mail

Model Mail is a mail system internal to the Enterprise Architect repository that allows users to send and receive mail messages. One of the important advantages that Model Mail has over other mail systems is that it is possible to embed hyperlinks to parts of the repository, allowing the recipient to click through to the diagrams, matrices, elements, Packages, reviews and more.

Most initiatives are carried out by a team of people, and critical to their success is good communication. With a fully featured tool such as Enterprise Architect, it is typical for team members to perform a lot of their work inside the tool; having mail internal to the repository provides a lot of advantages. The Model Mail facility allows team members and others using Enterprise Architect to send and receive mail messages including hyperlinks to repository content.

Where to find the Model Mail

Ribbon: Start > Today > Mail
Ribbon: Construct > Project > Discussion > Model Mail

Usage of the Model Mail

Model Mail can be used to send and receive mail messages internal to the model allowing team members and other stakeholders to communicate effectively about the model and its content. A typical scenario might be a team member sending a...
message with a link to a set of Requirements to a number of people asking for their comments.

**Options for the Model Mail**

Model Mail has the option to insert links to a variety of repository items including: Diagrams, Matrices, Images, Searches, Help Topics, Attributes, Operations, Team Reviews and More.

Learn more about the Model Mail

[Model Mail](#)
Model Search

Getting to know Model Search

Introducing Model Search

The Model Search facility is a powerful and flexible tool for finding anything in the modeling repository. An object can be located regardless of what a user is looking for, whether it is the name of an element, text in element notes, a Tagged Value or properties such as when an element was created, who created it, what its status is, and more. The facility includes a wide range of built-in searches that can be used or a user can define their own searches using the Query Builder, SQL Builder or by defining an Add-in Search.

With a number of analysts and others working on creating or importing content into the repository the number of elements will increase rapidly and before long even with a well organized model it will not be possible to remember where all the elements are located. The search facility can be used to locate information easily no matter where it is in the model.

Where to find Model Search

Ribbon: Start > Explore > Search > Search in Model
Ribbon: Design > Element > Manage > Search Model

Usage of Model Search

The Model Search facility can be used to find anything that exists in the repository. It can be used to return a set of elements that meet specified criteria for example in preparation for an iteration to get the list of all Requirements that were created in the last two weeks that have a Status of Validated and that have a Difficulty value of Low and a Priority of High. The result set can be sorted, documentation can be generated and individual elements can be Book Marked, or located in the Project Browser or in all the diagrams in which they appear.

Searches can be used as the basis of a number of other tools such as Model Views, the Documentation Generator and more.

Options for Model Search

A user can choose to use predefined searches or create their own user defined searches. Searches can be defined using three different tools: the Query Builder which is screen driven and easy for most non-technical analysts to understand or using the SQL Builder which uses SQL or by creating an Add-in Search which
requires some programming.

The Query Builder is the most intuitive of the tools and allows a user to build up their own query adding one or more filters to restrict the set of elements that will be returned.

The Search Facility can be configured to query a single package (and its sub-Packages if required) or to search the entire Repository.

Elements returned in the search results list can also be exported to a Word Processor or Spreadsheet Document.

Learn more about Model Search

Learn more about Model Search
Model Transformation

Getting to know the Model Transformation

Introducing Model Transformation

Model Transformations are a productivity tool that allow models to be manipulated to create more specialized or resolved models. The transformations can be applied to produce a variety of output models including logical and physical data models, XML Schema models, programming languages and more. The Model Driven Architecture (MDA) transformations use a flexible and fully configurable template system.

Where to find Model Transformation

Ribbon: Design > Tools > Transform > Transform Selection

Usage of Model Transformation

Model Transformations can be used as a productivity tool to transform a primitive model to a more resolved model. There is a wide range of built-in transformations, including:

- Generating from a Class model to a programming language model, including C++, C#, PHP, Java and many more
- Generating from a Class model to a data model, including ERD, Oracle, SQL Server, XSD and WSDL models
- Generating from a Class model to a test model, including NUnit and JUnit test models and more

Options for Model Transformation

Model Transformations are completely configurable using a powerful, simple and flexible template system. This includes the flexibility to create new user defined transformations and modify or extend existing ones.
Learn more about Model Transformation
Model Views

Getting to know Model Views

Introducing Model Views

Model Views provide an alternative view of the elements in the Repository. Whereas the Project Browser is designed to organize the packages and elements structurally the Model Views facility allows the modeler to create a number of views that can group elements and diagrams differently.

The Project Browser has been designed to organize the elements structurally grouping elements and diagrams together into packages based on factors such as namespaces, type of element and the part of the process. Model Views allow a user to create a structure based on a wide range of criteria including Favorites folders and folders based on a search such as all elements I created last week that have a status of 'Proposed'.

Where to find Model Views

Ribbon: Show > Window > Model Views
Ribbon: Start > Explore > Model Views

Usage of Model Views

Model views can be created for a variety of purposes and an experienced modeler will often use the Model Views facility as the access point to the Repository. The Favorites folder is useful to keep track of hand picked elements and diagrams of interest. The Slide show folder is useful to create a diagram slide show for the purposes of demonstrating diagrams to a group of people in a workshop or meeting. The Search folder is useful to keep track of elements that meet specified criteria and to be notified when new elements are added to the Repository that
meet the criteria.

**Options for Model Views**

The Model Views root folder defines views that every user can see, whereas the My Views root folder is only visible to the current user. Both these root folders can contain any number of user-defined folders down to two levels. User-defined folders under the Model Views folder can contain three types of view: Favorites, Diagram Slide Shows and views based on a Search. User-defined folders under the My View folders can contain only views based on a Search.

The Model Views window provides a convenient toolbar for working with the folders and elements.

**Learn more about Model Views**

Learn more about Model Views
Organizational Chart Diagram

Getting to know the Organizational Chart Diagram

Introducing the Organizational Chart Diagram

An organizational model is a powerful tool that is a visual representation that describes the roles, responsibilities and the reporting structure of an organization. It is invaluable to a Business Analyst as it allows them to visualize and to understand who they need to communicate with while performing various tasks. The Organization Chart in Enterprise Architect is flexible and can be used to create any type of representation including the inclusion of images representing teams or individuals.

This Organisation Chart diagram shows how the organizational structure of an Organisation can be represented graphically. Tree Vertical and Lateral Vertical line styles have been used to lay out the diagram.

Where to find the Organizational Chart Diagram

Ribbon: Design > Diagram > New > Strategic Modeling > Org Chart
Project Browser Caption Bar Menu: New Diagram | Strategic Modeling | Org Chart
Project Browser context menu: Add Diagram... | Strategic Modeling | Org Chart

Usage of the Organizational Chart Diagram

The Organizational Chart can be used to create any type of chart, including a Functionally Orientated, Market Orientated or Matrix Model chart. A number of charts could be created, representing different current and future states of the enterprise.
Options for the Organizational Chart Diagram

Apart from the relationships that represent reporting lines in the Organizational Chart, Business Analysts can also add relationships of authority, influence, and communication, which might not overlay the reporting lines. These additional lines can be modeled using named Associations and stereotyped if required.

The Organizational Chart (like any diagram) can be viewed as an element list, which makes working with the element's properties easier. Diagram Filters can also be used when presenting the diagrams, to draw attention to parts of the diagrams; the diagrams can be presented as hand drawn or in a whiteboard style by changing the properties of the diagram.

Learn more about the Organizational Chart Diagram

Organizational Chart
Package Browser

Getting to know the Package Browser

Introducing the Package Browser

The Package Browser is a powerful tool that provides a convenient list of the elements in a package displayed in a List or a Gantt view. The list view allows a modeler to work on the elements in the package in a spreadsheet like view, editing properties and notes inline and grouping and sorting the elements. The Gantt chart view allows analysts, architects, project managers and others to view the resource allocation for an element in a convenient and familiar time based view.

Where to find the Package Browser

Select the package in a diagram or the Project Browser

Ribbon: Design > Package > List View
Diagram Context Menu | View as List
Project Browser Context Menu | View as List

Usage of the Package Browser

The Package Browser provides a convenient and alternate view of the elements in a package. The list view can be used as a workbench for viewing the elements in user defined order, changing the elements properties and adding and deleting elements. The ability to display the elements grouped by various properties and Tagged Values allows analysis to be performed on groups of elements. The Gantt chart view provides a project management view of the elements showing how resources are allocated to individual elements. Reports for all, or a selected group of elements can be generated.

Options for the Package Browser

The Package Browser has two different formats or display options: a User Defined view and a Hierarchy view. The User Defined view displays all the elements in the Package regardless of hierarchy. The Hierarchy view arranges the elements in accordance with the way they are grouped in the Project Browser.
In the User Defined view the items can be sorted in ascending or descending order by clicking in the column headers. The order of columns can be changed by dragging column headers left or right. A modeler can drag column headers onto the View Header (above the column headers) this will group the items in the list by that property; column headers can be nested in a hierarchy to specify groups within groups.
Pan and Zoom

Getting to know Pan and Zoom

**Introducing Pan and Zoom**

The Pan and Zoom window is one of the tools that can be used to navigate around a large diagram. Often the resolution of a diagram must be reduced to ensure it is wholly visible but by using the Pan and Zoom window you can leave the diagram at a readable resolution and pan around to areas of interest zooming in when necessary.

Many initiatives will be best described by a number of large diagrams, ranging from A3 - A0. Even when you are fortunate enough to be using a large monitor you will want to change the scale at which you are viewing the diagram and then pan around to find the section or element of interest in the diagram and then zoom into that section. The Pan and Zoom window will allow you to do this for any size diagram with tools for panning and zooming which are particularly useful during workshops or focus groups.

**Where to find Pan and Zoom**

Ribbon: Layout > Tools > Pan and Zoom   (Ctrl+Shift+N)

**Usage of Pan and Zoom**

The Pan and Zoom window can be used for moving around and zooming into large diagrams. A typical scenario could be that an Analyst has created a diagram showing traceability from Solution Components back through detailed Requirements and User Stories and Processes up to the level of Business Goals. This diagram would typically be too large to view at the right resolution even on a large monitor. The Pan and Zoom window could be used to set the diagram resolution to a scale that could be easily read and then to pan around the diagram to elements and areas of interest, zooming in and out as required.

**Options for the Pan and Zoom**

The Pan and Zoom window has a number of options:

Panning can be achieved by using your mouse pointer to drag the colored
rectangle around to pan to different sections of the diagram.

Zooming can be achieved by using the Slider control which will change the scale of the diagram or by using the tool icons to:

- Zoom In
- Zoom Out
- Zoom to fit diagram
- Zoom to fit page
- Zoom to 100%

Learn more about Pan and Zoom

Pan and Zoom
Project Browser

Getting to know the Project Browser

Introducing the Project Browser

The Project Browser is the primary tool for structuring and navigating through the repository using expanding and collapsing tree nodes. The key structural element is the Package, which is a folder-like element that can contain other elements and diagrams, and other Packages. The elements in turn can contain other elements, features and diagrams. Root nodes are the highest nodes in the tree and these root Packages can contain views that in turn can contain any level of Packages and elements. Tree nodes including Packages, elements, Features and diagrams can be copied and pasted between locations or dragged and dropped to new locations. Many important tools, functions and windows are applied at the level of the Package, such as import or export of model content, documentation and Package Control, including Baselines.

Where to find the Project Browser

Ribbon: Show > Window > Project Browser
Ribbon: Start > Explore > Browser

Usage of the Project Browser

The Project Browser can be used to create and manage the structure of the repository by adding and deleting, moving and copying Packages, Elements,
Features and Diagrams. It is often the primary tool for exploring and browsing through the elements in the repository and finding things of interest. A modeler working with an open diagram will often want to locate a diagram object in the Project Browser as a way of finding out what package it belongs to and discovering its peers.

**Options for the Project Browser**

The Project Browser has a context menu that contains the import functions that apply to each of the selected element types. Many of the functions are also available in the Project Browser Toolbar positioned at the top of the window. This includes the ability to create Packages, diagrams, elements and documentation. The Project Browser itself can be moved around the workspace as required.

There are also several important ways the Project Browser can be configured by using the 'Preferences' dialog. These include the ability to Show or Hide stereotypes in the name of a tree node, the ability to freely sort the tree nodes within a Package or element and whether to warn about deletions from the tree. There is also the ability to configure the action that occurs when a node in the tree is double-clicked.

**Learn more about the Project Browser**

[Project Browser]
Project Management Items

Getting to know Project Management Items

**Introducing Project Management Items**

Project Management Items allow a modeler to define useful information about an element from the perspective of the management of the element. These include the Resources that can be allocated to work on the element, the Effort required to complete work on the element, Metrics that capture valuable information about a property of the element, and Risks associated with the element.

**Where to find Project Management Items**

- Ribbon: Construct > Task Management > Resource Allocation
- Ribbon: Construct > Change Management > Effort, Risks, Metrics
- Element Browser: | Project Management | Resource Allocation, Effort, Risks, Metrics

**Usage of Project Management Items**

Project Management Items can be added to assist in the management of a project. Specifying the resources that can be allocated to work on a particular element will assist with ensuring the right resources can be scheduled to carry out the work. The Effort required will also help in specifying exactly what resources will be required. The Metrics can provide useful and structured information about properties of the element such as the cost and time estimations. Risks can be defined that will assist in the overall management of project risks.

**Options for Project Management Items**

Project Management Items can be applied to any element in the Repository including Packages which is useful if a manager wants to assign an item such as Resource Allocation to a number of elements such as a group of Non Functional Requirements.

There is a convenient toolbar that allows you to manage any of the Project Management Items with icons for New (Item), Save, Delete, Sort and more.

**Learn more about Project Management Items**

[Project Management Items](#)
Relationship Matrix

Getting to Know the Relationship Matrix

Introducing the Relationship Matrix

The Relationship Matrix is a tool for visualizing the way that requirements are related to each other and to other elements in the model in a visually compelling matrix or spreadsheet like view. It can be used to view the relationship between Stakeholders and their Requirements, how Use Cases are related to Business Requirements or Functional Requirements, how Capabilities are related to Business Drivers, which Components implement a set of requirements, and more. Any number of matrices can be defined quickly and then saved to be viewed in workshops or included in documentation generated automatically from the model or exported to a spreadsheet file. When a matrix is created, connections can be viewed by placing the Requirements on one axis of the matrix and the connected elements on the other axis, then the cells of the matrix will indicate the direction of the relationship.

Where to find the Relationship Matrix

Project Browser Context Menu (Package): Relationship Matrix | As Source.../As Target.../As Both...

Resources Window: Matrix Profiles

Usage of the Relationship Matrix

To display the relationships that exist between elements in two Packages in a visually compelling matrix, such as which requirements are realized by which Use Cases. It is useful in analyzing missing elements or relationships; for example, to determine which Requirements are not realized by any Use Case or which Components do not have corresponding Requirements or Use Cases. It is particularly useful in workshops with Business Stakeholders who might not be familiar with seeing requirements in Trace diagrams.

Options for the Relationship Matrix

There are a range of options that can be set for the matrix including saving it to the Resources window or to a CSV format for opening in a spreadsheet. The
The appearance of the matrix can also be altered by sorting the elements, showing an outline numbering view, and suppressing Package names. These items are available from the Options button on the Relationship Matrix.

<table>
<thead>
<tr>
<th>Scale Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile</td>
<td>Matrix</td>
</tr>
<tr>
<td>Print Preview</td>
<td>Export to CSV...</td>
</tr>
<tr>
<td>Save as Metafile</td>
<td>Help</td>
</tr>
</tbody>
</table>

Learn more about the Relationship Matrix
Requirement Properties

Getting to Know the Requirement Properties

**Introducing Requirement Properties**

Requirement Properties are used to define metadata about the requirement that is useful for the management of requirements for the purpose of prioritization and defining work packages for the implementation teams. All Enterprise Architect elements have standard properties such as Status, Author and Phase but the Requirement element has additional properties such as Difficulty and Priority. User defined properties can also be defined using Tagged Values.

![Property Example]

**Where to find Requirement Properties**

Element Context Menu: Properties

or

Project Browser Context Menu | Properties...

Project Browser Context Menu | Properties Page | General, Requirements, Constraints, Scenarios, Files, Links, Tagged Values

**Usage of the Requirement Properties**

To define the important meta information about a requirement for the purposes of providing data to manage the requirements for prioritization, understanding which are the difficult requirements, and managing the lifecycle by using Status to determine requirements for implementation Packages.

**Options for Requirement Properties**

Enterprise Architect has a wide range of built in properties for all elements but it has a number of additional properties for requirements. If there are other properties that are needed by a modeler or team such as the volatility (stability) of a requirement these can be added using the general purpose UML extension mechanism of Tagged Values.


<table>
<thead>
<tr>
<th>REQ021 - List Stock Levels</th>
</tr>
</thead>
<tbody>
<tr>
<td>tags</td>
</tr>
<tr>
<td>Volatility = Medium</td>
</tr>
<tr>
<td>notes</td>
</tr>
</tbody>
</table>

A facility will exist to list current stock levels and to manually update stock quantities if physical checking reveals inconsistencies.
Requirements Checklist

Getting to know the Requirements Checklist

Introducing the Requirements Checklist

The Requirement Checklist is a convenient element that acts as a tally to indicate whether a Requirement complies with a set of predefined measures such as whether the Requirement is Atomic, Cohesive, Traceable and Verifiable. It can be assigned to any Requirement and the measures can be updated directly in the diagram. When working with requirements it is sometimes very useful to refer to a common set of 'best practices' and qualities that help define the nature of a well formed specification. The Requirement Checklist element is designed to meet this need.

REQ117 - The system must provide a mechanism allowing students to identify themselves

This diagram shows the use of a Requirements Checklist that acts as an indicator (check) to ensure the requirement is compliant with best practice. The check items are editable and a general checklist element is available that can be used with any element.

Where to find the Requirements Checklist

Toolbox | More Tools... | Requirements | Extended Requirements Page | Requirements Checklist

Usage of the Requirements Checklist

Analysts and Requirements Managers can use the checklist to annotate whether one or more requirements meet a set of predefined checks.

Options for the Requirements Checklist

The list of measures is completely configurable and items can be added or removed from the list for each individual checklist by using the Checklist Tagged Value notes.

```xml
<Checklist>
   <Item Text="Atomic" Checked="True"/>
   <Item Text="Attainable" Checked="True"/>
   <Item Text="Cohesive" Checked="False"/>
   <Item Text="Complete" Checked="False"/>
   <Item Text="Current" Checked="True"/>
   <Item Text="Independent" Checked="False"/>
   <Item Text="Modifiable" Checked="True"/>
   <Item Text="Traceable" Checked="True"/>
   <Item Text="Unambiguous" Checked="True"/>
   <Item Text="Verifiable" Checked="True"/>
</Checklist>
```

Learn more about the Requirements Checklist

Requirement Checklist
Requirements Diagram

Getting to Know the Requirements Diagram

Introducing the Requirements Diagram

The Requirements Diagram provides a visual representation of how Requirements are related to each other and to other elements in the model, including Business Drivers, Constraints, Business Rules, Use Cases, User Stories, design Components and more. The diagram is one of Enterprise Architect's extended diagram types and for analysts who are accustomed to working with requirements in a text based tool it will provide a welcomed and compelling graphical representation of the requirements.

REQ027 - Add Books
notes
A facility will be required to receive and add books to the stock lists.

REQ023 - Store and Manage Books
notes
A book storage and management facility will be required.

This diagram shows a Use Case that realizes a requirement. The realized requirement is part of a hierarchy of requirements expressed with the Aggregation relationship. The Use Case has an annotation under the element indicating its package location in the Project Browser.

Where to find the Requirements Diagram

Project Browser Context Menu: Add Diagram... | Extended | Requirements

Usage of the Requirements Diagram

One usage is to show how Requirements are connected together in a hierarchy but a more compelling usage is to show how requirements are connected to other elements. The experienced modeler will define and manage the requirements in the Specification Manager and then use the requirements diagram to show how one or more requirements are related to up-process elements such as Business Drivers and down-process elements such as Use Cases, User Stories, User Experience designs and solution Components.

Options for the Requirements Diagram

The appearance of a diagram can be changed to suit the audience, and details can be included, suppressed or altered to ensure the diagram meets its main objective of communication. There is a wide range of options ranging from creating a Hand Drawn style of diagram to page setup.
Learn more about the Requirements Diagram • Working In Diagrams
Risk Taxonomy

Getting to know the Risk Taxonomy

Introducing the Risk Taxonomy

The Risk Taxonomy is a facility to define a comprehensive, stable and reusable set of risk categories that can be applied universally across the system. This includes definitions of Threats, Loss type, Contact Frequency, Loss Magnitude, Risks and more. It is based on the Open Group Standard for Risk Taxonomy (OR-T) and provides a toolbox and diagrams for defining the Taxonomy.

Risk Taxonomy

The UML Profile for Risk Taxonomy provides support for modeling risk scenarios and analyzing risk conditions.

The Risk Taxonomy profile provided by Enterprise Architect supports the Open Group Standard for Risk Taxonomy (OR-T), version 2.0.

Where to find the Risk Taxonomy

Ribbon: Design > Diagram > New > Risk Taxonomy > Risk Taxonomy

Project Browser Caption Bar Menu: New Diagram | Risk Taxonomy | Risk Taxonomy

Project Browser Context Menu: Add Diagram... | Risk Taxonomy | Risk Taxonomy

Usage of the Risk Taxonomy

The Risk Taxonomy provides a common language and references for security and business analysts who need to understand and analyze risk in a formal way. It allows analysts to estimate the probable frequency and magnitude of future loss.

Options for the Risk Taxonomy

The Risk Taxonomy can be used at varying levels of formality depending on the initiatives, processes and requirements for risk assessment. The Relationship Matrix could also be used to record the relationship between the discrete values, Threat Capability and Resistance (Control) Strength to determine the derived Vulnerability. A Toolbox of elements and relationships is available for the Risk Taxonomy diagram allowing sophisticated models of risk to be created.
Learn more about the Risk Taxonomy

Risk Taxonomy
Roadmap Diagram

Getting to know the Roadmap Diagram

Introducing the Roadmap Diagram

The Roadmap Diagram is an overlay that can be applied to any diagram and describes significant phases in elements and how they change with the passage of time.

There is no restriction to the type of elements that can appear on the diagram and any diagram can have a Roadmap overlay defined. Significant user defined phases in the element's lifetime are represented by colored bars which can be set to show duration. The colors and the phases can be configured using a diagram legend which automatically applies them to the elements in the diagram. They are particularly useful for Enterprise Architecture diagrams for describing capability and application Roadmaps.

Where to find the Roadmap Diagram

Ribbon: Layout > Diagram > Roadmap
Diagram Context Menu: | Roadmap Options

Usage of the Roadmap Diagram

The Roadmap Diagram has a wide range of uses from Enterprise Architecture where they can be used to show application and capability roadmaps to Systems Engineering where they are used to show timing in low level components.

Options for the Roadmap Diagram

The Roadmap overlay has a range of options that determine the properties of the timeline, such as the scale of the time rulers, units, their positions, and the appearance of the time line including fonts and colors. The height and position of the timeline can also be configured to suit the diagram and display.
The diagram Legend can be configured to define the phases in the elements lifetime and to set the specification of the colored bands and more. Roadmap segments can be shown or hidden on individual elements in cases where a particular segment might not apply to one or more of the elements on the diagram.

Learn more about the Roadmap Diagram

Roadmap Diagram
Scenario Builder

Getting to Know the Scenario Builder

Introducing the Scenario Builder

The Scenario Builder is used to define the details of a Use Case including defining detailed descriptions, creating one or more Scenarios and defining pre-conditions, post-conditions and other constraints. The detailed steps of a Use Case can be recorded and linked to other elements in the model and these can then be generated out as a diagram providing a visual representation of the Use Case and its Scenarios. The diagram and the text can be synchronized and individual steps can then be traced to other elements such as Components that will realize the Requirement specified in the Use Case.

Where to find the Scenario Builder

Element Context Menu: Properties | Scenarios

Usage of the Scenario Builder

To define the details of a Use Case and its scenarios and constraints which can be used to replace the traditional text-document based approach to defining Use Cases. This ensures that the Use Case diagram and the textual details of the Use Cases and its Scenarios and Constraints are all contained in the same model and can be traced. If the Use Cases are required in a document format for contractual or process reasons a Use Case Report can be generated automatically from the models using the in-built documentation engine.

Options for the Scenario Builder

The Scenario Builder can be viewed as a tabbed or a docked window or in an element's Properties window. The steps of a Use Case including its Scenarios can be automatically generated into a number of different diagram types available from the Generate Diagram toolbar icon.
Learn more about the Scenario Builder

[Element Scenarios & Requirements]
Schema Composer

Getting to know the Schema Composer

Introducing the Schema Composer

The Schema Composer is a powerful and productive tool for working with information that is shared between organizations or within organizations. Many industries, domains, and organizations have defined a shared information model or schema and mandate or encourage parties to use this model when sharing information. The Schema Composer is a tool that helps analysts and others to define messages that comply with the schemas and thus comply with the mandated formats.

Where to find the Schema Composer

Ribbon: Design > Tools > Schema Composer > Open Schema Composer

Usage of the Schema Composer

The Schema Composer can be used to work with a number of standards including:

- The Common Information Model (CIM)
- National Information Exchange Modeling (NIEM)
- United Nations Center for Trade Facilitation and Electronic Business (UN/CEFACT) Modeling Methodology (UMM), specifically the Naming and Design Rules (NDR) 2.1 and 3.0
- Universal Business Language (UBL), specifically the Naming and Design Rules (NDR) 3.0

A modeler can however define their own schema using the tool either for use within an organization or as part of a standards or technical committee. Other standards will be added as more agencies and industry groups adopt the tool.

Options for the Schema Composer

The Schema Composer can also be used to create a definition of the same message using a number of different formats such as:

- XSD - (XML Schema Definition)
- RDFS - (Resource Description Framework Schema)
- JSON - (JavaScript Object Notation)

Learn more about the Schema Composer

Schema Composer
Security

Getting to know Security

Introducing Security

The Security system in Enterprise Architect is designed to facilitate collaboration and not as a barrier to incursion.

The information contained in the Repository is a valuable organizational asset and needs to be maintained and secured as such. The asset needs to be protected from both intentional and inadvertent compromises of content. The security system allows update functions to be restricted to a set of users or groups with the defined permission. Packages, Elements and Diagrams can be locked by users preventing others from updating them.

Where to find Security

Ribbon: Configure > Security

Usage of Security

Security has been designed to control access to update functions to groups and users who have been granted the access to perform these functions. Packages, Elements and Diagrams can also be locked for change by a Group or User preventing others from changing them. The security system has been designed primarily to facilitate collaboration and cannot be used to restrict users from viewing parts of the model.

Options for Security

Security itself is optional in Enterprise Architect and by default is not enabled. If it is required, security can be enabled and a security policy can be set. There are two policies that can be set which dictate the way security functions:

1. Require User Lock to Edit - (More Rigorous Policy) the whole project is locked against editing and the user must deliberately lock an element to be able to edit it.
2. User/group locking - (Less Rigorous Policy) the whole repository is unlocked. When a modeler edits an element or diagram the element or set of elements is automatically locked preventing others from editing them.
Any number of users and groups can be defined and users can be given individual permissions and also placed into one or more groups which have permissions defined. The set of permissions for a user is the sum of their individual permissions plus those of any groups they are assigned to. Users can be defined manually or imported from Active Directory allowing single sign-on using Windows Authentication.

Learn more about Security  Security
Sequence Diagram

Getting to know the Sequence Diagram

Introducing the Sequence Diagram

The Sequence Diagram is one of the Unified Modeling Language (UML) Behavioral diagrams that can be used to define the time ordered flow of messages between elements. They can be used by business and technical users but are more commonly used for technical descriptions of a system. Time is by convention represented on the vertical axis and elements (Classifiers or Instances) are positioned horizontally at the top of the diagram. Commonly an Actor (representing a role played by a user) starts the flow and messages are passed between the elements showing how a result is achieved.

Where to find the Sequence Diagram

Ribbon: Design > Diagram > New > UML Behavioral > Sequence
Project Browser Caption Bar Menu: New Diagram | UML Behavioral | Sequence
Project Browser Context Menu: Add Diagram... | UML Behavioral | Sequence

Usage of the Sequence Diagram

The Sequence Diagram can be used to model any set of messages that flow between two or more elements to produce a result. They are more typically used by technical modelers to depict how messages are passed between application components and interfaces to achieve an outcome. They are particularly useful when used to describe complex protocols or subsystem interactions that are difficult to understand unless presented graphically. Sequence diagrams can also be created automatically from stack traces as a way of visualizing how a system functions.

Options for the Sequence Diagram

The elements that appear in Sequence Diagrams can be either Classifiers such as Classes and Components or instances such as Objects and Component Instances. The choice will depend on what the modeler wants to represent. The order of objects and messages can be altered to make the diagram more readable and notes can be used to explain parts of the diagram. Fragments can also be added to represent control structures that operate on a group of messages.
Learn more about the Sequence Diagram
# Specification Manager

## Getting to Know the Specification Manager

### Introducing the Specification Manager

The Specification Manager is the central tool for working with requirements and provides a Word Processor or Spreadsheet like interface for entering, maintaining and viewing Requirements. New Requirements can be created with names and detailed descriptions and properties such as Status and Priority can be added from drop-down lists. Existing Requirements can be viewed and managed in a convenient view and changing them in the Specification Manager will change them in all other places in the repository such as diagrams and windows. It is the perfect tool for those analysts more comfortable working with text rather than diagrams and who are accustomed to working in a Word Processor or Spreadsheet. It has the added advantage that the requirements are part of a model and can be traced to other elements including Business Drivers, Stakeholders and Solution Components.

### Where to find the Specification Manager

- Project Browser Context Menu (Package): View as Requirements List

### Usage of the Specification Manager

To create, view and maintain Requirements in a text based tool that resembles working in a word processor or spreadsheet. Details can be added to the requirements and requirement properties can be added from drop-down lists. When the requirements are changed in this Specification Manager the changes are conveniently reflected in the Project Browser and all other windows.

### Options for the Specification Manager

There are a wide range of options available from the options menu, to tailor the

---

1. **REQ019 - Manage Inventory**
   - The system MUST include a complete inventory management facility to store and track stock of books for the on-line bookstore.

   1.1 **REQ021 - Inventory Reports**
      - Inventory reports are required that detail the available stock for each item including back orders. Future stock level reports should be able to predict the quantity of stock at a specified future date.

   1.2 **REQ023 - Store and Manage Books**
      - A book storage and management facility will be required.

      1.2.1 **REQ022 - Order Books**
         - A book order facility will be required to allow on-line ordering from major stockist's.

      1.2.2 **REQ021 - List Stock Levels**
         - A facility will exist to list current stock levels and to manually update stock quantities if physical checking reveals inconsistencies.

---

(c) Sparx Systems 2015 - 2017
**Specification Manager**

way you use the Specification Manager. These include Level (hierarchical) Numbering, Auto Naming, Spell Check, Documentation, Import and Export of Requirements, access to various related tools and more.

Learn more about the Specification Manager [The Specification Manager](#)
StateMachine Diagram

Getting to know the StateMachine Diagram

Introducing the StateMachine Diagram

The StateMachine Diagram is one of the Unified Modeling Language (UML) Behavioral diagrams that can be used to model the important phases in the lifetime of an element. It is often thought of as a diagram for technical uses but it has equal applicability for non-technical audiences. The StateMachine is defined for a selected entity in the system and a perspective is defined that will be modeled by the States and other elements and connectors in the diagram.

In Catalogue

Removed from Catalogue

Book Released

addToCatalogue

This state machine illustrates composite states - in which a super state has nested sub-states to show the detailed level of states that can exist within the super state.

OnOrder

received

In Stock

order [qty > stock] /reorder

Order [qty <= stock]

removeFromCatalogue

Removed from Catalogue

Where to find the StateMachine Diagram

Ribbon: Design > Diagram > New > UML Behavioral > StateMachine

Project Browser Caption Bar Menu: New Diagram | UML Behavioral | StateMachine

Project Browser Context Menu: Add Diagram... | UML Behavioral | State Machine

Usage of the StateMachine Diagram

The StateMachine diagram is used to model the important phases in the lifetime of a system entity. It can be used to model business entities such as Bank Accounts or technical entities such as a Traffic Light Control system.

Options for the StateMachine Diagram

The StateMachine diagram can be automatically converted to an analogous model in a State Table Editor. This can be an appealing representation for some users and the editor provides an easy to use interface to add new States and Transitions. StateMachine diagrams and Tables can be used to create Model Simulations that will allow the modeler to visualize, explore and test the dynamic behavior of the StateMachine.

StateMachines can also be used for to generate code into Hardware Description Languages (HDL).
The StateMachine Diagram (like any diagram) can be viewed as an element list which makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams to draw attention to parts of the diagrams and the diagrams can be presented as hand drawn or in a whiteboard style by changing the properties of the diagram.
Stereotyping

Getting to know Stereotyping

Introducing Stereotyping

Stereotypes are one of the Unified Modeling Language Extension Mechanism that can be used to create a new type of element based on an existing UML element type. There are many cases where things of interest in a particular industry or domain would benefit from being defined as a type. The stereotyped elements often add clarity to a model and are meaningful to a model audience who is familiar with their domain. Examples include a 'contract' stereotype in the legal profession, a 'policy' stereotype in the compliance profession or a 'meter' stereotype in the energy distribution industry.

Stakeholder Requirements

This diagram shows a number of stakeholders and their needs (requirements). A stereotype has been created for the stakeholders, that has an alternate image assigned to it. The requirements are displayed using a rectangular presentation style, so as to display the stereotype «<stakeholder requirement>> in the diagram.
audiences. Care should be taken not to overuse the facility as it can lead to fragmentation of meaning and also can result in models that are not understood by external audiences.

**Options for Stereotyping**

Stereotypes can have a number of appearance settings applied that help to distinguish the element type. These include changing the default colors of the element and changing the appearance by assigning an image or a new shape to elements with the applied stereotype. The image is best defined in a vector format such as a metafile so that when it is resized the image doesn't become pixelated. A shape script can be defined which uses a user defined script to draw the element effectively allowing any style of element to be drawn and conditionally adding graphic features based on properties and tagged values.

Learn more about

**Stereotyping**

[Stereotypes](#)

[Stereotype Settings](#)
Strategy Map

Getting to know the Strategy Map

Introducing the Strategy Map

A Strategy Map is a diagram that is used to describe the primary strategic goals that are important to an organization or business team. The diagram shows four important perspectives that are the significant questions that provide the definition of a strategy. The most commonly defined perspectives are: ‘Financial’, ‘Customer’, ‘Internal Business Processes’, ‘Learning and Growth’. The diagram is used as a communication device to ensure there is a common understanding of the strategy, to focus organization effort and to assist with the assessment of progress.

Where to find the Strategy Map

Ribbon: Design > Diagram > New > Strategic Modeling > Strategy Map
Project Browser Caption Bar Menu: New Diagram | Strategic Modeling | Strategy Map
Project Browser context menu: Add Diagram... | Strategic Modeling | Strategy Map

Usage of the Strategy Map

The Strategy Map is used to model the key strategic goals that an organization or management team intend to achieve. Elements in each of the four perspectives can be linked to other elements in the repository to show how they could be
implemented at a business, application or technology level.

**Options for the Strategy Map**

A Strategy Map can be created using Patterns that automatically create elements and a diagram that can be used as a starting point for the strategy map. There are three Patterns available, ranging from a very simple expression with a single element in each perspective to a completely worked expression with multiple elements in each perspective. A toolbox provides a range of additional elements and relationships to extend the base maps created using the Patterns.

Learn more about the Strategy Map

Strategy Map
Tagged Values

Getting to know the Tagged Values

Introducing the Tagged Values

Tagged Values are one of the Unified Modeling Language's built-in extension mechanisms. They provide a useful and productive way of adding extra properties to elements, attributes, operations or connectors; just as you would add an additional column in your favorite spreadsheet. They have a Tag name and a Value, and additional Notes. You can use a wide range of user interface controls to assist users when entering a value for the tag, such as drop downs, spin controls, date and color pickers, and more.

There are a variety of properties available for elements in the Repository, including name, notes, status, author and version. Even with these properties available, it is likely that an analyst will need to add additional properties in some situations, and the Tagged Values facility is an easy to use and productive mechanism for working with these properties.

Where to find Tagged Values

Defining Tagged Values
Ribbon: Configure > Reference Data > UML Types > Tagged Value Types

Using Tagged Values
Ribbon: Start > Windows > Tagged Values

Usage of the Tagged Values

Tagged Values are additional properties (and their values) that can be set for any UML element, attribute, operation or connector. For example a Requirement element does not have a built in property for volatility and so a Tagged Value could be added providing the user with a drop down list of available values: such as High, Low, Medium.

Tagged Values are used extensively in profiles and technologies. For example you will use them when working in the BPMN Technology to set properties of Activities or in the Wire Framing Technology to show or hide phone menu buttons and notification bars.

Options for the Tagged Values

There are built in Structured Tagged Value Types that help the user when entering the value for a tag. The values can be restricted using user interface controls such as drop down lists, spin controls, date selectors and many more.
For example a date picker can be applied to allow a user to select the date a Change was authorized.

Learn more about the Tagged Values

<table>
<thead>
<tr>
<th>Tag Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Risk Mitigation</td>
<td>Treatment of Risk</td>
</tr>
</tbody>
</table>

Type=Enum;
Values=Avoidance, Reduction, Sharing, Retention;
Default=Reduction;
Team Reviews

Getting to know Team Reviews

**Introducing Team Reviews**

Team reviews provide an opportunity for developers, modelers, customers and stakeholders to comment and provide feedback on the work in progress or at the completion of a milestone or project.

---

**Usage of Team Reviews**

The Team Review feature can be used to conduct model reviews from any number of perspectives including walk-throughs, formal model reviews, or ad-hoc reviews.

---

**Where to find Team Reviews**

---

**Options for Team Reviews**

There is a wide range of settings available to configure the Team Reviews available from the Category and Topic context menus, including setting the status of the category or topic and other options. Diagrams, elements and element features can be conveniently dragged from the Project Browser to create model links that can be used by team members to hyperlink directly from the Team Review window to these items in the Project Browser.
Learn more about Team Reviews

Team Review
Enterprise Architect has a number of tools that can be used for modeling aspects of the test discipline. The Testing Window is the central tool for creating and managing tests, allowing a range of different test types to be defined including properties such as status and the results of tests to be recorded.

**User Stories**

As a Stock Control Manager I want to be able to list stock levels for a selection of titles.

- **responsibilities**
  A user must be warned when the report generation time is going to be more than one minute.
  Back ordered titles must only be included in total when the available stock is zero.

- **constraints**
  (The solution must use available Stored Procedures)

- **tags**
  Volatility = High

- **test scripts**
  System: : (Fail) No titles selected
  System: : (Deferred) Two titles selected one with no stock
  Acceptance: : (Pass) Five non contiguous titles selected

- **maintenance**
  Task: (New) Create application logic to display results in a table
  Task: (Verified) Create table index to ensure fast retrieval of stock levels
  Task: (New) Decide on UI mechanism to multiselect a number of Titles
  Decision: (Verified) Display back order as negative stock

**Introducing the Testing**

The Testing Window allows a number of different types of tests to be created and managed. These support the most common types of testing, and include:

- **Unit tests** - to test Classes, Components and other elements as they are implemented
- **Integration tests** - to test how the implemented artifacts and components work together
- **System tests** - to test that the system performs the right business functions correctly
- **Acceptance tests** - to test the system against user requirements and acceptance and evaluation criteria
- **Scenario tests** - to test the application with real-world situations and scenarios
- **Inspection tests** - to record peer reviews using a well-defined process

**Options for the Testing**

The Testing Window allows a modeler to record metadata for the tests, including:

- The name of the Test
- The status of the test
- Who the Test was run by
- The Type of Test (such as Regression)

**Where to find the Testing**

- **Ribbon:** Construct > Testing > Test Windows > All, Inspection, Unit, Integration, System, Acceptance, Scenario
- **Element Browser:** | Testing | All, Inspection, Unit, Integration, System, Acceptance, Scenario

**Usage of the Testing**

The Testing window allows a number of different types of tests to be created and managed. These support the most common types of testing, and include:

- **Unit tests** - to test Classes, Components and other elements as they are implemented
- **Integration tests** - to test how the implemented artifacts and components work together
- **System tests** - to test that the system performs the right business functions correctly
- **Acceptance tests** - to test the system against user requirements and acceptance and evaluation criteria
- **Scenario tests** - to test the application with real-world situations and scenarios
- **Inspection tests** - to record peer reviews using a well-defined process
• Who it was Checked by
• The Class of Test (such as Acceptance)
• The Date it was last run
• Description of the Test
• Inputs required
• Acceptance Criteria
• Results

Learn more about the Testing
Traceability Window

Getting to Know the Traceability Window

Introducing the Traceability Window

The Traceability window gives the modeler a hierarchical view of element connections, allowing traceability to be visualized and queried as elements are traversed in the model. This tool is particularly powerful because a modeler will often choose to hide diagram relationships but by selecting an element in the diagram and viewing its connections in the traceability window all its relationships will be displayed.

Where to find the Traceability Window

Show > Window > Traceability

Usage of the Traceability Window

The Traceability Window can be used to view the way an element is connected to other elements in the repository, in a hierarchy including the types of the relationships. This window gives a complete list of all relationships that cannot be seen by viewing elements in the Project Browser and might not appear in any diagrams. It is very useful for managing requirements and tracing how a requirement is related to up-process elements such as Business Drivers and down-process elements such as Components. It is a useful tool for newcomers to a model to gain a quick understanding of which are the important and well connected elements. It should be viewed before deleting an element in the model to ensure that the user understands the element's existing relationships.

Options for the Traceability Window

There are a series of options that restrict the traceability to specified connector types; these can be set to alter what is displayed in the window. The options are available from the toolbar at the top of the window.
Learn more about the Traceability Window

The Traceability Window
Use Case Diagram

Getting to know the Use Case Diagram

**Introducing the Use Case Diagram**

The Use Case Diagram is one of the Unified Modeling Language (UML) Behavioral diagrams that can be used to describe the goals of the users and other systems that interact with the system that is being modeled. They are used to describe the functional requirements of a system, subsystem or entity and present a simple but compelling picture of how the system will be used.

They are typically used in conjunction with higher level Business and Stakeholder Requirements and are often supplemented with a set of Non Functional Requirements.

**Where to find the Use Case Diagram**

Ribbon: Design > Diagram > New > UML Behavioral > Use Case

Project Browser Caption Bar Menu: New Diagram | UML Behavioral | Use Case

Project Browser Context Menu: Add Diagram... | UML Behavioral | Use Case

**Usage of the Use Case Diagram**

The Use Case Diagram is used to describe the goals that users or other systems want to achieve from interacting with the system. They always describe the goal from the Actors' perspective, the details of the Use Case will describe the goal with more precision.

Use Cases will often act as the basis for the definition of Test Cases.

**Options for the Use Case Diagram**

Any number of Use Case Diagrams can be created to represent different parts of a system or Packages of Use Cases. The diagrams can be kept simple or they can be
structured by the application of a number of additional connectors such as Include, Extend and Generalization relationships.

A system Boundary can be included that is used to name the system, subsystem or entity under discussion; the Actors lie outside the Boundary and the Use Case inside.

Use Case diagrams can be used to show how the Use Case are related to other elements in the system, including up-stream elements such as Requirements and down-stream elements such as Components.

The Use Case diagram (as for any diagram) can be viewed as an element list, which makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams, to draw attention to parts of the diagrams and the diagrams can be presented as hand drawn or in a whiteboard style by changing the properties of the diagram.

Learn more about the Use Case Diagram

Use Case Diagram
Use Case Estimation

Getting to know Use Case Estimation

Introducing Use Case Estimation

Use Case Estimation is a comprehensive project estimation tool that is used to calculate effort using Use Case and Actor elements. The complexity of the work environment is set using a series of weighted Technical and Environmental Complexity factors and Use Cases and Actors are given a rating that assigns their complexity as: Easy, Medium or Complex. The method is based on Karner's Use Case Points Method, and allows a metrics report containing the project estimation analysis to be produced and incorporated into project documentation.

Where to find Use Case Estimation

Ribbon: Configure > Reference Data > Project Types > Estimation Factors

Usage of Use Case Estimation

Use Case Estimation can be used to calculate the required effort to complete an initiative or part of an initiative.

Options for Use Case Estimation

Environmental and Technical complexity factors can be defined and given weights and values that determine how they influence the effort that is calculated for an initiative.
A value can be assigned to the phase property of one or more Use Cases; this value can be used subsequently as the criteria of a filter to restrict the estimates to just that phase. The estimate can also be filtered based on a Tagged Value set on the Use Cases such as Criticality.

Learn more about Use Case Estimation
User Story

Getting to know the User Story

Introducing the User Story

User Stories are most often associated with iterative processes and were originally defined by Extreme Programming techniques but are now more commonly associated with a number of Agile processes. A User Story typically consists of a simple statement made in a few short sentences describing what the user does or needs to do to achieve a goal and why the goal is important to them. They are typically written to replace detailed traditional requirements and allow developers to understand the goals of a user and what their job functions entail.

As a Stock Control Manager I want to be able to list stock levels for a selection of titles.

Notes

Customers often order a number of titles particularly students buying a list of books at the commencement of the academic year. It is important to be able to view stock for a list of titles at the same time.

This diagram shows how a User Story can be modeled using a stereotyped Use Case. This allows the User Story to be described and to show the connection to a Persona. As a Sprint is being defined detailed Requirements can be developed just-in-time for the development work to begin.

Where to find the User Story

Toolbox Page: Artifacts | User Story

Usage of the User Story

User Stories are useful as an alternative way of describing user requirements. They are used as part of certain Agile processes, to provide a simple but clear description of what the user does or needs to do as part of the role they perform. They also typically describe the reason behind the goal the user wants to achieve.
Options for the User Story

A User Story can be created using the stereotyped Artifact available from the 'Artifact' Toolbox page or as a stereotyped Use Case. While many proponents of User Stories see them differently to Use Cases, they are both aimed at defining a goal that a user in a role wants to achieve. A stereotyped Use Case can also be used to represent a User Story with just the description written in the form: 'As a (Stock Controller) I want to be able to...'. They can be defined in conjunction with Personas that help to allow analysts to empathize with the users.

Learn more about the User Story

User Story
**Value Chain**

**Getting to know the Value Chain**

**Introducing the Value Chain**
The Value Chain is a strategic diagram that allows the primary and secondary activities in an organization to be modeled. The diagram can be created from a Pattern that adds and connects the five primary activities in a chain and the four supporting activities underpinning them.

![Value Chain Diagram](image)

An analyst working at the strategic business unit level will often be asked to model the activities the business unit performs to provide value to its customers. The Value Chain is the preferred tool for creating this strategic representation of the sequence of activities that an organization performs.

**Where to find the Value Chain**
- Ribbon: Design > Diagram > New > Strategic Modeling > Value Chain
- Project Browser Caption Bar Menu: New Diagram | Strategic Modeling | Value Chain
- Project Browser context menu: Add Diagram... | Strategic Modeling | Value Chain

**Usage of the Value Chain**
The Value Chain is an important tool to assist with strategic planning allowing the whole sequence (or chain) to be understood. It also allows the chain to be broken down into its constituent activities allowing the evaluation of costs, resource and value to be determined and potentially improved.

**Options for the Value Chain**
Each one of the Primary and Supporting Activities can be linked to other elements in the model including a linked document and elements that define benchmarks.
The Value Chain Diagram (like any diagram) can be viewed as an element list which makes working with the element's properties easier.

Diagram Filters can also be used when presenting the diagrams to draw attention to parts of the diagrams.

Learn more about the Value Chain
Visual Filters

Getting to know Visual Filters

**Introducing the Visual Filters**

Visual Filters provide a mechanism for filtering out parts of a diagram or list of elements that are not of interest leaving just the elements and connectors that are relevant to the view. The filters can be defined for elements or connectors and there are a wide range of criteria that can be set such as filter out all elements that don't have a status of 'Validated' and were created since a milestone date.

Model stakeholders typically have different interests and often only part of a diagram or element list will be relevant to them. Visual filters can assist by allowing you to filter out parts of a diagram or list of elements leaving just the elements and connectors that they want to see. This is a powerful tool in workshops, focus groups and meetings allowing a modeler to present a single diagram in many different ways.

**Where to find the Visual Filters**

Ribbon: Layout > Tools > Diagram Filters

**Usage of the Visual Filters**

Visual Filters can be defined at a Repository level making them available to all users. The application of the filter is however specific to the current user, so two analysts could apply different filters to the same diagram or list simultaneously.
**Options for the Visual Filters**

There are a number of options available from the Visual Filters Toolbar including being able to change the way the element obscuration is presented from: Fade, Gray Scale, Hide and Select.

Context filtering can be applied so that only the element selected in the diagram and its directly connected elements will be enabled, this can be enabled from the Visual Filters window Context Menu. The filtering effect can be to hide, fade or gray scale the irrelevant elements; the Select option will conversely select the elements of interest in the diagram or list.

**Learn more about the Visual Filters**

[Visual Filters]
Introducing the Wire Frame Diagram

Wire Framing is a productive tool that can be used to create visually compelling and realistic models of commercially available phones, tablets, screens and web pages. The diagrams assist Business Analysts, Experience Designers and others communicate with stakeholders, allowing them to demonstrate the solution interfaces.

This diagram shows the rich support for creating wireframe models of modern portable devices such as cell (mobile) phones and tablets. The toolbox has rich support for a wide range of pre-built controls applicable to the main types of devices in use including Apple and Android devices. Parts of the interface can be linked to other elements in the repository creating powerful traceability.

Many stakeholders will understand how a solution is going to work if they can see something concrete and visual. The Wire Framing tool is perfect for this situation where a mock-up of the user interface of a phone, tablet or web page is created including page layout, interface and navigational controls representing different parts of a User Story or Use Case.

Where to find the Wire Frame Diagram

Ribbon: Design > Diagram > New > Wireframing > Apple, Android, Dialog, Webpage, Windows Phone Wireframe

Project Browser Caption Bar Menu: New Diagram | Wireframing | Apple, Android, Dialog, Webpage, Windows Phone Wireframe

Project Browser context menu: Add Diagram... | Wireframing | Apple, Android, Dialog, Webpage, Windows Phone Wireframe
Usage of the Wire Frame Diagram

A Business Analyst or Experience Designer will typically create Wire Frame models for the devices that are being targeted in the solution. The interface elements and navigational controls can be connected to other elements in the Repository. For example a drop down list could be connected to a data source indicating the origin of the data. A slide show could also be created to walk a stakeholder through a sequence of diagrams representing the flow through a User Story or Use Case.

Options for the Wire Frame Diagram

There are built in toolboxes for the most common types of devices, including:

- Android Phones and Tablets
- Apple iPhones and Tablets
- Windows Phones
- Screen Dialogs
- Webpages

The toolboxes contain elements for the devices, pages and screens and a wide range of controls, widgets and other elements. Tagged Values can be set to hide or display elements of the interface such as phone menu buttons and notification bars.
Diagram Filters can also be used when presenting the diagrams to draw attention to parts of the diagrams, and the diagrams can be presented as hand drawn or in a whiteboard style by changing the properties of the diagram.

Learn more about the Wire Frame Diagram

Wire Framing
Working Sets

Getting to know Working Sets

Introducing Working Sets

Working Sets are a powerful way of saving a group of Workspace items such as diagrams and matrices so they can be re-opened as a set at a later time. This allows a modeler to switch between multiple tasks without losing the context of the items they are working on.

A Business Analyst will often work on a number of tasks simultaneously and each task will typically require the application of a number of techniques and tools including diagrams, matrices, documents and more. Working Sets allow a user to save groups of windows and diagrams they are working on as a set, giving the group a name so it can be easily recalled and the items opened as a set at a later time.

Where to find Working Sets

Ribbon: Start > Today > My Work Sets

Usage of Working Sets

Working Sets can be used to store a group of items open in an Enterprise Architect workspace as a set that can be reopened at a later time. A typical scenario is that a Business Analyst is working on a particular task and has a number of relevant diagrams and matrices and documents open that define parts of a problem or solution for a particular initiative. Suddenly they receive an urgent request to complete an unrelated task. They could save the open items as a Working Set so that once the urgent matter had been attended to the group of items could be easily reopened.

Options for Working Sets

Working Sets allow a number of different items to be added to a set including:

- Diagrams
- Matrix Profiles
- Searches
- Team Reviews
- Document Templates
- Resource Documents
Any number of each type of item can be added to a Working Set and the contents of the set can be edited and diagrams can be located in the Project Browser.

There are a range of options available from the Working Set name context menu including being able to make the working set available to other model users by choosing the Share option.

Learn more about Working Sets
XML Schema Generation and Import

Getting to know XML Schema Generation and Import

Introducing XML Schema Generation and Import

The XML Schema Generation and Import is a built-in facility to model, forward engineer and reverse engineer XML Schemas. XML Schema Definition (XSD), also known as XML Schema, is a World Wide Web Consortium (W3C) XML technology and is used in a wide range of industries to encourage standards compliance and messaging using a common schema. The XSD specifies the rules to which an XML document must adhere and can be automatically validated by a number of tools.

Where to find XML Schema Generation and Import

Ribbon: Code > Tools > XSD > Import XSD, Export XSD

Usage of XML Schema Generation and Import

The XML Schema Generation and Import facility can be used to visualize or create a model of an XML Schema (XSD). This is particularly useful when the repository is describing shared messages or a schema that is based on a standard.

Options for XML Schema Generation and Import

An XML Schema can be created using an in-built model transformation applied to an abstract Class diagram or it can be modeled using the XML Schema Toolbox page using a Class diagram. Either way the completed schema model can be generated to create an XSD file using names and details specified in the Tagged Values of the Schema Package. There is also a purpose built tool for working with schemas called the Schema Composer, which allows messages to be created based on part of a schema.
Learn more about XML Schema Generation and Import

XSD Models